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Введение 

В результате изучения дисциплины предполагается формирование 

следующих компетенций: 

ПК 1.2. Проводить предпроектный анализ для разработки дизайн-

проектов. 

ПК 1.3. Осуществлять процесс дизайнерского проектирования с 

применением специализированных компьютерных программ. 

ПК 1.4. Производить расчеты технико-экономического обоснования 

предлагаемого проекта. 

ЛР 4 Проявляющий и демонстрирующий уважение к людям труда, 

осознающий ценность собственного труда. Стремящийся к формированию в 

сетевой среде личностно и профессионального конструктивного «цифрового 

следа». 

Компетенции ПК 1.2-1.4 формируется в результате выполнения 

лабораторных работ № 1-18 

Зашита самостоятельной лабораторной работы осуществляется в 

виде письменного ответа в тетради на поставленные вопросы. 
 

В отличие от программ 2D-графики, в 3ds MAX вы столкнетесь с 

трехмерными объектами, которые обладают такими характеристиками, как 

ширина, длина и высота. Таким образом, совершенно очевидно, что для 

достоверного отображения такого объекта необходимо использовать три 

различных вида на него. Зds MAX по умолчанию использует вид сверху (Тор), 

слева (Left) и спереди (Front). Также имеется еще одна проекция — перспектива 

(Perspective), которая используется скорее для контроля за сценами, так как 

работать в ней довольно сложно (см. рис.1). В любом случае отображения в 

окнах проекции можно свободно переключать, а также увеличивать в четыре 

раза и уменьшать до исходного размера, о чем будет сказано ниже.  



 

 

Рис. 1 – Отображение трехмерного пространства в Зds MAX 

Еще из школьного курса черчения вам известно, что для отображения 

трехмерного пространства используются три координатных оси, 

расположенных перпендикулярно друг другу (см. рис.2).  

Для виртуального трехмерного пространства можно считать, что ось Z 

соответствует понятию высоты, ось Х – ширины, а ось 

Y – глубины сцены. 

 

Поэтому неудивительно, что в разных окнах проекции расположение этих осей 

выглядит по-разному.  

 

 

 

Рис. 2 – Три координатных оси, используемые для 

отображения трехмерного пространства 



 

Каждый объект в Зds MAX имеет собственную (локальную) систему 

координат. При перемещении или повороте объекта она перемещается вместе с 

ним относительно основной координатной системы. Численные параметры 

перемещения объекта по различным осям можно увидеть в нижней части окна 

программы. 

По своей роли все объекты в 3ds MAX могут быть разделены на 

визуализируемые и вспомогательные. Визуализируемые объекты используются 

для отображения внешнего образа предметов окружающего мира.  

Вспомогательные объекты не визуализируются, но играют важную роль 

при анимации, освещении, отображении, имитации физических свойств. 

Вспомогательные объекты могут быть по своей природе любыми – камеры, 

источники освещения, системы костей ("скелеты"), объекты, помогающие 

ориентироваться в пространстве при создании сцены, и так далее. 

Визуализируемые объекты в некоторых ситуациях могут также служить и 

вспомогательными объектами. 

Визуализируемые объекты могут иметь практически любую форму, но для 

того чтобы эту форму можно было хранить в памяти компьютера, все объекты 

представляются как набор геометрических примитивов, которые могут быть 

описаны при помощи формул и численных параметров. Наиболее 

распространённый метод описания геометрических объектов – представление 

их в виде многогранников. Как известно, многогранник состоит из граней (face) 

и вершин (vertex), любая грань может быть разделена на n-ное количество 

треугольников. Каждая вершина имеет свои координаты в трёхмерном 

пространстве (x,y,z) и свой порядковый номер. Каждый треугольник также 

имеет свой порядковый номер и описывается посредством перечисления трёх 

номеров вершин, между которыми он натянут. Объекты, которые описываются 

таким образом, называются каркасом (mesh). 

Метод представления трёхмерных объектов посредством mesh далеко не 

единственный, можно описывать объекты и посредством математических 



 

формул, задающих их поверхность. Но на сегодняшний день метод mesh 

является общепринятым и широко распространённым, поддерживается в 

видеокартах на аппаратном уровне. Объекты могут моделироваться и 

представляться пользователю совершенно по-разному, но, перед тем как 

осуществляется визуализация или отображение в окнах проекций в режиме 

оттенения (shading), всё равно происходит преобразование в объект mesh. 

Многие вспомогательные объекты (камеры, источники света, 

исказители (деформаторы), имитаторы физических сил) вообще не могут быть 

визуализированы, поскольку у них не предусмотрена возможность 

преобразования в mesh. Они используются для того, чтобы управлять формой 

объектов, которые сводятся к mesh (придавать им деформацию), а также  

помогать контролировать движение других объектов, как визуализируемых, так 

и вспомогательных.  

Каждый объект имеет собственную систему координат. Форма всех 

объектов, которые могут быть преобразованы в mesh (а по большому счёту и 

тех, которые отображаются в виде икон в окнах проекций), описывается в 

собственной системе координат. Положение объекта задаётся при помощи 

трансформаций (перемещение (трансляция), поворот и масштабирование) 

относительно системы координат. 

Все создаваемые объекты привязаны к некоему нематериальному 

объекту world – мир, который представляет собой глобальную систему 

координат, где и располагаются все остальные объекты. Местоположение 

(трансляция) объекта определяется координатами центра его собственной 

(локальной (local)) системы координат. Поворот объекта определяется 

поворотом локальной системы координат объекта (вокруг центра) 

относительно мира (world), а масштабирование – это изменение размеров 

объекта относительно тех, которые он имеет в собственной системе координат. 

Итак, объект имеет собственную систему координат, в которой и 

задаётся его форма. К примеру, если речь идёт о mesh-объекте, то координаты 

вершин задаются в его собственной системе координат и именно в таком виде 



 

информация об объекте хранится в файле и в памяти компьютера. Положение 

(координаты) вершин в мире (world) пересчитывается заново всякий раз, как 

объект подвергается трансформации (трансляции, врашению и 

масштабированию), но в описании самого объекта координаты вершин по 

прежнему остаются неизменными. Трансляции объекта можно довольно легко 

анимировать. Можно также анимировать и положение вершин объекта в его 

локальной системе координат, но это осуществляется при помощи 

модификаторов. Модификаторы действуют подобно трансляциям, они не 

портят сам объект, не переписывают координаты его вершин в его локальной 

системе координат. Они просто пересчитывают эти координаты по 

определённым правилам, и уже перед нами объект предстаёт видоизменённым. 

В итоге каждый отдельный объект, составляющий какую-либо 

модель, состоит из некого исходника, который хранит в себе начальные 

сведения, и модификаторов (их может и не быть), которые преобразуют 

начальные сведения определённым образом.  

 

  

Практическая работа №1 Знакомство с 3ds MAX. Интерфейс программы. 

Создание и сохранение пользовательского интерфейса (часть1) 

 

Цель и содержание работы 

Цель работы – изучить интерфейс программы. Последовательное 

выполнение поставленных задач поможет на практике быстро настраивать 

пользовательский интерфейс программы для персональной работы. 

Теоретическое обоснование 

После запуска 3ds MAX на экране монитора появится интерфейс 

программы (рис.1). 



 

 

Рис. 1 – Вид стандартного интерфейса программы 3ds MAX 

Верхняя строка главного меню у программы 3ds MAX выглядит 

примерно так же, как и у большинства программ. Сразу под ней располагается 

строка с инструментами, которая называется Main Toolbar – главная строка 

инструментов. В начале главной строки инструментов находятся две кнопки - 

undo (отменить действие) и redo (вернуть отменённое действие). 

Все кнопки, расположенные за undo и redo, служат для: 

• управления объектами: привязка к другим объектам, выделение, 

перемещение, вращение, масштабирование, выбор вспомогательной 

системы координат и центра поворота; 

•  для манипулирования; 

• размещения объектов в сцене; 



 

• открытия окон доступа к параметрам объектов и материалов, а также 

глобальных параметров сцены; 

• визуализации (создания конечного изображения или видеоряда) и 

установки её параметров.  

 В правой части интерфейса программы расположена командная панель – 

Command Toolbar, которая обеспечивает быстрый доступ к параметрам 

объектов и операций. Выбирая соответствующие вкладки в этом меню можно 

получить доступ к следующим операциям: 

•   Create – создание объектов;  

•   Modify – модификация объектов – изменение параметров, 

преобразование, редактирование объектов (в том числе создание 

собственных моделей на основе каких-либо объектов), добавление 

модификаторов;  

•   Hierarchy – настройка иерархии объектов – то, как объекты связаны 

друг с другом;  

•   Motion – управление движением объектов; 

•   Display – настройка того, что и как будет отображаться на экране. 

Здесь можно также скрыть (hide) или заморозить (frize) объекты. 

Скрытые объекты не видны, а замороженные – недоступны для 

редактирования;  

•   Utilites – утилиты, средства для совершения дополнительных действий 

над объектами, сценой и группами объектов.  

При нажатии на кнопку открывается соответствующая вкладка с 

параметрами. Существуют также группы меню, открывающиеся по правому 

щелчку мышью, для разных ситуаций эти меню будут разными. 

 

Методика и порядок выполнения работы 

Запустите программу 3ds MAX. 

Задание 1. Освобождение дополнительного пространства 



 

1. Панель с инструментами, расположенная у левой кромки интерфейса, 

полностью продублирована в программе, поэтому ее можно убрать, тем 

самым освободив себе больше пространства для оперативной информации. 

Для этого кликните правой кнопкой мыши по панели и уберите флажок 

reactor.  

2. Если вы хорошо видите, можно сделать кнопки поменьше. В меню 

Customize / Preferences (предпочтения) во вкладке General (основные) в 

группе параметров UI Display (отображение пользовательского 

интерфейса) уберите флажок Use Large Toolbar Bottons (использовать 

большие кнопки на панели инструментов) и нажмите Ok. 

3. После того как вы нажмёте Ok, появится сообщение: "Please exit and restart 

the program in order to change the toolbar botton size", – это не что иное, как 

просьба выйти и перезапустить программу для того, чтобы размер кнопок 

изменился. Перезапустите программу. 

Задание 2.  Перемещение панели Command  к левой кромке окна 

программы  

1. По умолчанию, панель Command находится в правой части окна 3ds MAX, 

однако любую панель программы можно довольно просто “прикрепить” к 

левой границе окна. Это удобно, если, например, вы левша. Для того 

чтобы переместить панель Command, кликните мышью на пустом месте 

панели, справа от вкладки Utilities, и перетащите указатель к центру окна 

программы. Обратите внимание, как изменится форма указателя во время 

перетаскивания панели Command от правой кромки окна. 

2. Не отпуская кнопку мыши, перетащите панель Command к левому краю, 

пока вновь не появится упомянутая выше форма указателя, сигнализируя о 

том, что присоединение панели возможно. 

3. Если вы перетащили панель к центру окна 3ds MAX и отпустили кнопку 

мыши, то панель Command будет плавающей, т.е. не прикрепленной ни к 

одной границе окна. Чтобы все-таки прикрепить ее к левой части экрана, 

кликните в строке ее заголовка правой кнопкой мыши и из появившегося 



 

контекстного меню выберите команду Dock → Left (Прикрепить → К 

левой границе окна).  

4. Если кликнуть на кнопке Close (Закрыть), расположенной в правом 

верхнем углу плавающей панели Command, то панель, естественно, будет 

закрыта. Чтобы вновь отобразить панель Command, выберите команду 

Customize → Show UI → Show Command Panel (Настройка → Показать 

пользовательский интерфейс → Показать панель Command). 

 

                                     

        Практическая работа №2 Знакомство с 3ds MAX. Интерфейс 

программы. 

        Создание и сохранение пользовательского интерфейса (часть2) 

 

Цель и содержание работы 

Цель работы – изучить интерфейс программы. Последовательное 

выполнение поставленных задач поможет на практике быстро настраивать 

пользовательский интерфейс программы для персональной работы. 

Теоретическое обоснование 

После запуска 3ds MAX на экране монитора появится интерфейс 

программы (рис.1). 



 

 

Рис. 1 – Вид стандартного интерфейса программы 3ds MAX 

Методика и порядок выполнения работы 

Запустите программу 3ds MAX. 

 

Задание. Сохранение и загрузка пользовательского интерфейса 

1. Для того чтобы сохранить настройки пользовательского интерфейса, 

выберите команду Customize → Save Custom UI Scheme (Настройка→ 

Сохранить настроенный пользовательский интерфейс).  После ее 

выполнения появится диалоговое окно Custom Scheme 

(Пользовательские настройки). В этом окне выбирают изменения 

пользовательского интерфейса, которые должны быть сохранены в .ui-

файле.  



 

2. Кроме этого, вы можете выбрать тип пиктограмм интерфейса – 

стандартные (переключатель Classic) или черно-белые (переключатель 2D 

Black and White). Выберите стандартные (переключатель Classic) и 

нажмите Ok. 

3. Перезапустите 3ds MAX. Программа запустилась со стандартным 

интерфейсом. Для того чтобы запустить сохраненный пользовательский 

интерфейс, воспользуйтесь командой Customize → Load Custom UI 

Scheme (Настройка → Загрузка настроенного пользовательского 

интерфейса).  Запустите пользовательский интерфейс, сохраненный ранее, 

или default.ui (интерфейс, загружаемый по умолчанию при первой 

инсталляции программы). 

Команды Save Custom UI Scheme и Load Custom UI Scheme меню 

Customize можно использовать для сохранения и загрузки любых типов файлов 

пользовательского интерфейса 3ds MAX, а именно: 

• файлов интерфейса (.ui); 

• файлов пользовательского интерфейса (.cui);  

• файлов меню (.mnu);  

• файлов цветов (.clr);  

• файлов комбинаций клавиш (.kbd);  

• файлов свойств квадменю (.qop). 

4. Чтобы случайно не повредить настройки интерфейса, выполните команду 

Customize (Настройка), поставьте флажок Lock UI Layout (Закрепить 

расположение пользовательского интерфейса). Лучше всего сделать это 

до начала всех операций, поскольку при работе можно повредить 

настройки пользовательского интерфейса неосторожным щелчком мыши. 

 

 

 

 

 

 



 

Практическая работа №3 Виды проекций в 3ds MAX. Работа с окнами 

проекций 

 

Цель и содержание работы 

Цель работы – научиться понимать трехмерное пространство, 

отображенное в окнах проекций. Данная Практическая работа направлена на 

изучение основных приемов манипулирования окнами проекций.  

Теоретическое обоснование 

Основу интерфейса программы  3ds MAX составляют четыре окна 

проекций, в которых отображаются объекты сцены с разных сторон (рис. 1). 

 

Рис. 1 – Окна проекций в 3ds MAX 

Активное окно проекции помечено жёлтым. Для того чтобы окно проекции 

стало активным, достаточно кликнуть в него мышью.  



 

У каждого окна проекции в левом верхнем углу отображается название 

вида, который в данный момент отображается в окне. По умолчанию окна 

проекций настроены на виды Top (вид сверху), Front (вид спереди), Left (вид 

слева) и Perspective (вид в перспективе). Как видно на рисунке 1, во всех видах, 

кроме Perspective, объект отображается в виде проволочного каркаса. При 

желании можно настроить виды так, чтобы и в них объект отображался 

оттенённым. Надписи с названиями видов также являются меню окна 

проекции, которое можно открыть, если щёлкнуть по слову правой кнопкой 

мыши (рис.2). 

 

Рис. 2 – Меню окна проекции с видом Top 

Рассмотрим наиболее полезные и понятные на данном этапе пункты этого 

меню. В первой группе можно выбрать режимы отображения объектов. 

• Smooth+Highlights – сглаживание+блики; 

• Wireframe – проволочный каркас;  



 

• Other;  

o Smooth – сглаживание;  

o Facets+Highlight – фасеты+блики;  

o Facets – фасеты;  

o Lit Wireframe – оттенённый и раскрашенный проволочный каркас;  

o Bounding Box – параллелепипеды, ограничивающие объект;  

• Edged Faces – ограниченные грани;  

• Transparency – отображение прозрачности; 

o Best – наилучшая;  

o Simple – простая;  

o None – нет. 

Для того чтобы разобраться, что всё это означает, нужно понять, как же 

отображаются объекты в трёхмерной графике. Все объекты в конечном счете 

состоят из треугольников, опирающихся на заданные вершины. К одной и той 

же вершине может прилегать несколько треугольников. 

                   

                 а                                         б                                         в 

Рис.3 – Проволочный каркас объекта (а), отображение в виде фасетов (б) и с 

применённым сглаживанием граней (в) 

Для того чтобы объект не выглядел гранёным, применяется так 

называемое сглаживание (smooth) при визуализации. Грани на экране при 

визуализации закрашиваются таким образом, чтобы переходы между ними 

были плавными, и объект казался гладким. Геометрия самого объекта при этом 



 

не меняется, сглаживание происходит уже когда сформирована проекция 

нашего объекта на плоскость. 

Как видно на рисунке 3 (в), сфера выглядит гладкой, но её силуэт всё 

равно представляет собой не круг, а многоугольник с большим числом сторон. 

Процесс сглаживания граней требует некоторого времени, поэтому в сложных 

сценах для ускорения обновления видов бывает полезно отключить 

сглаживание и блики и выбрать режим Facets (фасеты). Если сцена совсем уж 

сложная, приходится отображать все объекты в виде ограничивающих их 

параллелепипедов (bounding box). Отображение бликов также потребляет 

ресурсы компьютера, поэтому предусмотрены режимы, когда блики не 

отображаются. 

Edged Faces – обведённые грани – вещь, полезная при моделировании. 

Если включён режим отображения Smooth+Highligh или Smooth, у нас не видно 

переходов между гранями. Edged Faces показывает их в виде проволочного 

каркаса, наложенного поверх модели. Рёбра граней могут быть видимыми, 

тогда они отображаются в режимах Wireframe и при включённом Edged Feces, и 

невидимыми, тогда их можно увидеть только в режиме Fecets, если грани, 

примыкающие к ребру, расположены под некоторым углом либо в особом 

режиме редактирования самого объекта и режиме окна проекции Wireframe. 

 

Рис.4 – Так выглядят объекты, когда включён режим Edged Faces. Невидимые 

рёбра не отображаются 



 

Примечание: Клавиша F4 включает или выключает режим Edged Faces без 

доступа в меню вида. 

Transporency – здесь можно выбрать, как отображать прозрачность в окнах 

проекций. Эта опция никак не влияет на визуализацию. 

Show Grid – показывать сетку. Если эту опцию отключить, то серой сетки 

в окне проекции не будет видно. Вообще, сетка служит для отсчёта координат, 

а также для ориентации в неортогональных (неперпендикулярных) видах, 

служит опорной системой координат для создания объектов.  

Show Safe Frame – показывать безопасный кадр. Если эта опция выбрана, 

в окне проекции сцена будет ограничиваться рамкой, пропорции которой 

соответствуют пропорциям конечной картинки, которую мы будем 

визуализировать. Это поможет лучше "прицелиться" при выборе ракурса. 

Views – позволяет выбрать другой вид для текущего окна проекции. 

• Perspective – перспектива;  

• User – пользовательский;  

• Front – вид спереди;  

• Back – вид сзади;  

• Top – вид сверху;  

• Bottom – вид снизу;  

• Left – вид слева;  

• Right – вид справа;  

• Active Shade – активное оттенение – показывает, как будет 

выглядеть сцена после визуализации. Использовать этот режим не 

рекомендуется, поскольку в нём тщательно прорабатываются все детали, 

что требует большого времени. Выйти из этого режима можно, если 

кликнуть по окну вида правой кнопкой мыши и в развернувшихся окнах 

меню, в левой верхней секции выбрать Close (закрыть).  

• Scematic – помещает в окно проекции схематический вид. Этот вид 

отображает имена объектов и связи между ними в виде графа. 

Расположением узлов графа можно управлять;  



 

• Grid – вид, перпендикулярный сетке. Имеет смысл, если создать 

вспомогательную сетку. Если вспомогательной сетки нет, то у вас на 

выбор будут вышеперечисленные ортогональные виды; 

• Extended – расширенный режим, отображает в окне проекции 

опции объектов и сцены в целом, даёт доступ к контролю этими 

параметрами; 

• Shape – форма.  

Примечание.  Виды и окна проекций не одно и то же. Виды – это то, что 

отображается в окнах проекций, хотя меню окна отображается 

как название вида, относится оно к окну. В этом же меню можно 

выбрать и то, какой вид отображать в этом окне, тогда название 

вида меняется. 

Если в сцене имеются камеры и/или источники света, в меню 

выбора видов появляются их имена и можно выбрать вид из 

камеры или через источник света. 

Configure... –  конфигурация. Обширный пункт, но его параметры не 

будут рассмотрены, поскольку для понимания их значения требуются довольно 

богатые знания как пакета, так и трёхмерной графики в целом.  

 

Практическая работа №4 Управление ракурсом видов 

Цель и содержание работы 

Цель работы – научиться понимать трехмерное пространство, 

отображенное в окнах проекций. Данная Практическая работа направлена на 

изучение основных приемов манипулирования окнами проекций.  

 

Теоретическое обоснование 



 

Здесь будут описаны средства, которые применяются для того, чтобы 
В

и
д

 ч
ер

е
з 

к
а
м

ер
у

 

- 
D

o
ll

y
 C

am
er

a 
- 

тр
ан

сл
я
ц

и
я
 

к
ам

ер
ы

 -
 п

р
и

б
л
и

ж
ен

и
е 

и
 у

д
ал

ен
и

е
 

- 
P

er
sp

ec
ti

v
e 

- 
н

ац
ел

и
в
ан

и
е 

к
ам

ер
ы

 с
 п

ер
ем

ещ
ен

и
ем

 в
д

о
л

ь
 о

си
 

зр
ен

и
я
 

R
o
ll

 C
am

er
a 

- 
в
р
ащ

ен
и

е 
в
о
к
р
у

г 

о
си

 з
р
ен

и
я
 к

ам
ер

ы
 

- 
Z

o
o

m
 E

x
te

n
ts

 A
ll

 -
 и

зм
ен

я
ет

 в
се

 в
и

д
ы

, 
к
р

о
м

е 
в
и

д
а
 ч

ер
ез

 к
ам

ер
у

 т
ак

и
м

 о
б

р
аз

о
м

, 
ч

то
б

ы
 в

 н
и

х
 в

м
ещ

ал
и

сь
 в

се
 в

и
д

и
м

ы
е 

о
б

ъ
ек

ты
 с

ц
ен

ы
 

- 
Z

o
o

m
 E

x
te

n
ts

 A
ll

 S
el

ec
te

d
 -

 р
аб

о
та

ет
 а

н
ал

о
ги

ч
н

о
 Z

o
o

m
 E

x
te

n
ts

 A
ll

, 
н

о
 в

м
ещ

ае
т 

в
 в

и
д

ы
 т

о
л
ь
к
о
 в

ы
д

ел
ен

н
ы

е 
о

б
ъ

ек
ты

 

- 
F

ie
ld

-O
ff

-V
ie

w
 м

ен
я
ет

 у
го

л
 

зр
ен

и
я
 

- 
T

ru
ck

 C
am

er
a 

п
ер

е
м

ещ
ае

т 

к
ам

ер
у
 п

о
 г

о
р
и

зо
н

та
л

и
 

- 
O

rb
it

 C
am

er
a 

- 
в
р
ащ

ен
и

е 
к
ам

ер
ы

 

с 
п

ер
ем

ещ
ен

и
ем

 в
в
ер

х
-в

н
и

з,
 

- 
P

an
 C

am
er

a 
- 

п
р
о
и

зв
о
л
ь
н

о
е 

в
р
ащ

ен
и

е 
к
ам

ер
ы

 б
ез

 и
зм

ен
ен

и
я
 

п
о
л

о
ж

ен
и

я
 в

 п
р
о
ст

р
ан

ст
в
е
 

П
ер

сп
е
к

т
и

в
а

 

- 
Z

o
o

m
 -

 у
в
ел

и
ч
ен

и
е 

в
 а

к
ти

в
н

о
м

 в
и

д
е
. 
У

в
ел

и
ч

ен
и

е 
та

к
ж

е 
р

аб
о

та
ет

, 
ес

л
и

 к
р

у
ти

ть
 

к
о
л
ёс

и
к
о

 м
ы

ш
к
и

, 
н

о
 п

ер
ед

 э
ти

м
, 

н
ад

о
 х

о
тя

 б
ы

 о
д

и
н

 р
аз

 к
л
и

к
н

у
ть

 в
 о

к
н

о
 в

и
д

а,
 и

н
а
ч
е 

к
р
у

ти
ть

ся
 б

у
д

ет
 ч

то
-н

и
б

у
д

ь
 д

р
у

го
е.

 

- 
Z

o
o

m
 A

ll
 -

 у
в
ел

и
ч
ен

и
е 

о
д

н
о
в
р
ем

ен
н

о
 в

о
 в

се
х

 в
и

д
ах

 

- 
Z

o
o

m
 E

x
te

n
ts

 -
 и

зм
ен

я
ет

 в
ы

б
р
ан

н
ы

й
 в

и
д

 т
ак

, 
ч

то
б

ы
 в

 н
ег

о
 в

м
ещ

ал
и

сь
 в

се
 

в
и

д
и

м
ы

е 
о

б
ъ

е
к
ты

 с
ц

е
н

ы
  

- 
Z

o
o

m
 E

x
te

n
ts

 S
el

ec
te

d
 -

 и
зм

ен
я
ет

 в
ы

б
р

ан
н

ы
й

 в
и

д
 т

ак
, 

ч
то

б
ы

 в
 н

ег
о

 в
м

ещ
ал

и
с
ь
 в

се
 

в
ы

д
ел

ен
н

ы
е 

о
б

ъ
ек

ты
 

- 
R

eg
io

n
 Z

o
o

m
 

- 
F

ie
ld

-O
ff

-V
ie

w
 

- 
P

an
 -

 п
ер

е
та

ск
и

в
ае

т 
в
и

д
 б

ез
 и

зм
ен

ен
и

я
 у

гл
а 

зр
ен

и
я
 и

 у
гл

а 
п

о
в
о

р
о

та
 к

ам
ер

ы
. 

Е
сл

и
 

в
ы

б
р

ан
а 

к
ам

ер
а,

 э
то

 п
р
и

в
о
д

и
т 

к
 п

ер
ем

ещ
ен

и
ю

 к
ам

ер
ы

 в
 п

л
о

ск
о

ст
и

, 
п

ар
ал

л
ел

ь
н

о
й

 

в
и

д
у

. 

- 
A

rc
 R

o
ta

te
 -

 в
р
ащ

ен
и

е 
в
и

д
а 

в
о

к
р
у
г 

ц
ен

тр
а 

М
и

р
а 

 

- 
A

rc
 R

o
ta

te
 S

el
ec

te
d

 -
 в

р
ащ

ен
и

е 
в
и

д
а 

в
о

к
р

у
г 

ц
ен

тр
а 

в
ы

б
р

ан
н

о
го

 о
б

ъ
ек

та
 

- 
A

rc
 R

o
ta

te
 S

u
b

O
b

je
ct

 -
 в

р
ащ

ен
и

е 
в
и

д
а 

в
о

к
р

у
г 

в
ы

б
р

ан
н

о
го

 п
о

д
о

б
ъ

ек
та

, 
ес

л
и

 

в
к
л
ю

ч
ён

 р
еж

и
м

 р
аб

о
ты

 с
 п

о
д

о
б

ъ
ек

та
м

и
. 

И
н

ач
е 

р
аб

о
та

ет
 к

ак
 A

rc
 R

o
ta

te
 S

el
ec

te
d

. 

О
р

т
о
г
о

н
а
л

ь
н

ы
й

 в
и

д
 

   

- 
R

eg
io

n
 Z

o
o
m

 -
 у

в
ал

и
ч

и
в
ае

т 
в
ы

б
р

ан
н

у
ю

 о
б

л
ас

ть
 т

ак
, 

ч
то

б
ы

 о
н

а 
ц

ел
и

к
о

м
 з

ан
и

м
ал

а 
в
ес

ь
 в

и
д

 

Т
а
б

л
и

ц
а

 1
 –

 У
п

р
ав

л
ен

и
е 

в
и

д
ам

и
 

 



 

нацелить виды на нужные объекты. Все средства управления видами находятся 

в правом нижнем углу окна программы. Виды могут быть ортогональными, 

перспективными, либо видом через камеру (или источник света). По 

умолчанию, вид через камеру имеет перспективу, однако камеру тоже можно 

переключить в ортогональный режим. 

 

К ортогональным видам относятся: User – пользовательский, Front – вид 

спереди, Back – вид сзади, Top – вид сверху, Bottom – вид снизу, Left – вид 

слева, Right – вид справа. Перспективный вид – Perspective. Вид через камеру 

представляет собой особенный вид, и для него некоторые инструменты 

выглядят иначе. 

Если в каком-либо из ортогональных видов использовать любой из трёх 

инструментов Arc Rotate, вид перестаёт быть перпендикулярным координатным 

сеткам и автоматически преобразуется в вид User. Вид User является 

ортогональным, поскольку отображение объектов в нём происходит 

посредством ортогональной проекции на плоскость экрана. 

Min/Max Toggle – эта кнопка делает активный вид большим, а все 

остальные виды убирает. То есть после нажатия на эту кнопку активный вид 

займёт собой всё пространство, отведённое под окна проекций. После 

повторного нажатия на эту кнопку виды вернутся в прежнее состояние.  

Методика и порядок выполнения работы 

Задание. Навигация в активном окне проекции 

1. Запустите программу 3ds MAX. 

2. Откройте файл, предоставленный преподавателем, в котором содержится 

модель собаки.  

3. Будем работать с окном проекции Perspective (Перспектива). Для того 

чтобы его активизировать, кликните мышью в пустом поле окна. После 

этого окно станет активным, на что будет указывать желтая рамка вокруг 

него. 



 

4. Щелкните на кнопке Min/Max Toggle (Переключатель 

минимизации/максимизации) или нажмите комбинацию клавиш 

<Alt+W>, чтобы увеличить окно Perspective до размеров экрана, перекрыв 

остальные окна проекций.  

5. Щелкните на кнопке Pan (Панорамировать) (<Ctrl+P>) и перетащите 

указатель мыши в окне проекции, пока голова животного не появится в 

центре окна. Затем щелкните на кнопке Zoom (Масштабировать) или 

нажмите комбинацию клавиш <Alt+Z> и перетаскивайте указатель мыши, 

пока голова собаки не заполнит окно проекции, как показано на рис. 5.  

 

Рис. 5 –  В окне проекции Perspective голова собаки приближена с 

помощью элементов управления Zoom и Pan 

6. С помощью команды Views→Save Active Perspective View сохраните 

текущий вид головы животного в окне проекции.  

7. Воспользовавшись кнопкой Zoom Extents (Масштабировать до 

заполнения) (<Ctrl+Alt+Z>), сделайте видимым в текущем окне проекции 

все тело собаки.  



 

8. Щелкните на кнопке Arc Rotate (Повернуть), затем на правом маркере 

направляющей вращения и перетащите указатель мыши справа налево. 

Таким образом, вы развернете модель собаки так, чтобы лучше видеть ее 

переднюю часть (рис. 6).  

 

Рис. 6 – Вид в окне проекции Perspective после вращения модели собаки 

 

 

Практическая работа №5 Загрузка фонового рисунка 

 

Цель и содержание работы 

Цель работы – научиться понимать трехмерное пространство, 

отображенное в окнах проекций. Данная Практическая работа направлена на 

изучение основных приемов манипулирования окнами проекций.  

 

Методика и порядок выполнения работы 

Задание. Создание модели из фонового рисунка. 



 

 

 

Воспользовавшись цифровой камерой, можно существенно ускорить 

работу по моделированию реальных объектов. Для этого достаточно 

сфотографировать реальный объект сверху, спереди и слева, а затем загрузить 

полученные снимки в качестве фоновых рисунков окон проекции Top, Front и 

Left соответственно. Таким образом, фоновые рисунки послужат отправной 

точкой для создания нужной модели.  

1.     Запустите программу 3ds MAX 

2.Создайте новый файл, выбрав команду File→New (Файл→Создать) или 

нажав <Ctrl+N>.  

3.Щелчком правой кнопкой мыши активизируйте окно проекции Front и в 

главном меню программы выберите команду Views→Viewport Background. 

Появится диалоговое окно Viewport Background (Фон окна проекции).  

4.Щелкните на кнопке File (Файл). С помощью появившегося диалогового 

окна Select Background Image откройте файл front view, jpg, предоставленный 

преподавателем, и щелкните мышью на кнопке Open (Открыть). 

5.В диалоговом окне Viewport Background установите переключатель Match 

Bitmap (Согласовать с растром), флажок Display Background (Отображать 

фон) и переключатель Active Only (Только активное окно проекции). 

Щелкните на кнопке ОК, чтобы закрыть диалоговое окно Viewport 

Background. В окне проекции Front появится выбранный вами фоновый 

рисунок.  

6.Повторите шаги со второго по четвертый для окон проекции Тор и Left. На 

рис. 7 показано окно программы 3ds max с загруженными фоновыми рисунками 

в окна проекции Front, Top и Left.  



 

 

Рис. 7 – Фоновые изображения можно использовать в качестве отправной 

точки в процессе моделирования объектов 

 

 

Практическая работа №6 Объекты в 3ds MAX. Создание и редактирование 

(часть1) 

 

Цель и содержание работы 

Цель работы – научиться создавать объекты и изучить способы их 

редактирования. В процессе выполнения лабораторной работы вы 

познакомитесь со способами создания некоторых типов объектов, входящих в 

категорию Geometry, которые являются основой для создания гораздо более 

сложных объектов.  

Теоретическое обоснование 

Термин объекты (objects) в 3ds MAX относится ко всем элементам сцены. 

Практически к любым из них могут применяться преобразования и 



 

модификаторы. Имеется семь категорий объектов: Geometry (Геометрия), 

Shapes (Формы), Lights (Источники света), Cameras (Камеры), Helpers 

(Вспомогательные объекты), Space Warps (Объемные деформации) и 

Systems (Системы). Они получили название параметрических, то есть 

имеющих определенный набор параметров, таких как координаты положения 

объекта, его размеры по длине, высоте и ширине, число сегментов или сторон и 

т.п.  

Есть также четыре отдельных типа объектов, которые не относятся к 

данным категориям и называются редактируемыми: Editable Spline 

(Редактируемый сплайн), Editable Patch (Редактируемый кусок), Editable 

Poly (Редактируемая полисетка) и Editable Mesh (Редактируемая сетка).  

Остановимся на наборе стандартных примитивов  (куб, шар, геосфера, 

цилиндр и т.д.), входящих в категорию Geometry. Несмотря на свое название, 

они являются основой для создания гораздо более сложных объектов.  

Если посмотреть на рисунок 1, то можно заметить, что прямоугольник 

(Box) состоит из большого количества квадратиков. На самом деле он 

образован множеством маленьких треугольников, имеющих вершины и грани. 

Итак, давайте ознакомимся со следующими понятиями: Vertex – вершина, в 

которой соединяются линии (напр., ребра), Edge – ребро – линия, соединяющая 

соседние вершины, Face – грань, это и есть площадь элементарной единицы 

сетки.  

 

 Рис. 1 – Элементы сетки объекта: 1 — вершины; 2 — ребра; 3 — грани  



 

 

Методика и порядок выполнения работы 

Задание. Построение каркасного параллелепипеда 

1. Загрузите программу 3ds MAX.  

2. Кликните на кнопке Geometry (Геометрия) (рис.2) и выберите в списке 

разновидностей объектов Extended Primitives (Улучшенные 

примитивы). В свитке Object Type (Тип объекта) появятся кнопки с 

надписями, соответствующими типам стандартных примитивов.  

 

 

 

 

 

 

 

 

 

3. Кликните на кнопке Chamfer Box (Параллелепипед с фаской). В нижней 

части командной панели появятся три свитка: Creation Method (Метод 

создания), Keyboard Entry (Клавиатурный ввод) и Parameters 

(Параметры).  

4. Кликните в окне проекции Perspective (Перспектива) и, не отпуская 

кнопку, перетащите курсор по диагонали, растягивая основание. Следите 

за изменением величин параметров Length (Длина) и Width (Ширина) в 

свитке Parameters (Параметры).  

5. Отпустите кнопку мыши для фиксации длины и ширины основания.  

6. Переместите курсор при отпущенной кнопке мыши вверх или вниз, чтобы 

задать высоту параллелепипеда. Следите за значением параметра Height 

(Высота) в свитке параметров.  

Рис. 2 – Extended Primitives (Улучшенные 

примитивы) в списке разновидностей 

объектов вкладки Geometry (Геометрия) 



 

7. Кликните еще раз для фиксации высоты. После щелчка мыши, 

фиксирующего высоту, передвиньте курсор еще на некоторое расстояние 

вверх и щелкните левой кнопкой мыши еще раз. Расстояние, которое вы 

отмерили сейчас, будет равно ширине фаски, срезаемой под углом в 45°. 

Задать высоту фаски можно также с помощью параметра Fillet (Фаска).  

8. Включите режим сглаживания поверхности фаски Smooth 

(Сглаживание). В результате построенный параллелепипед должен иметь 

вид, показанный на рис.3.  

 

 

Вы получили параллелепипед с числом сегментов, равным 1 (следует 

по умолчанию). Для изменения количества сегментов надо выставить 

параметры Lengt Segs (Сегментов по длине) и Width Segs (Сегментов по 

ширине). Увеличение числа сегментов бывает необходимо для последующего 

редактирования сетчатой оболочки объекта. Число сегментов в пределах фаски 

можно задать с помощью переменной Fillet Segs (Сегментов по фаске). 

 

 

Практическая  работа №7 Объекты в 3ds MAX. Создание и 

редактирование (часть2) 

 

Цель и содержание работы 

Цель работы – научиться создавать объекты и изучить способы их 

редактирования. В процессе выполнения лабораторной работы вы 

познакомитесь со способами создания некоторых типов объектов, входящих в 

Рис. 3 – Построенный параллелепипед  



 

категорию Geometry, которые являются основой для создания гораздо более 

сложных объектов.  

 

Задание. Построение цилиндра с фаской 

1. Загрузите программу 3ds MAX.  

2. Нажмите на командной панели Create (Создать) кнопку Geometry 

(Геометрия), в списке выберите вариант Extended Primitives (Улучшенные 

примитивы) и нажмите кнопку Chamfer Cyl (Цилиндр с фаской).  

3. Установите переключатель свитка Creation Metod (Метод создания) в 

положение Edge (От края) для построения основания цилиндра от одного края 

к другому, растягивая его по диаметру.  

Если вы желаете построить основание от центра по величине радиуса, 

нужно установить переключатель Center (От центра).  

4. Кликните в той точке любого из окон проекции, где будет располагаться 

начальная точка основания цилиндра и, не отпуская клавиши мыши, перетяните 

курсор, растягивая основание. Отпустите кнопку мыши, зафиксировав тем 

самым радиус основания.  

Величина параметра Radius (Радиус) в свитке Parameters 

(Параметры) отражает изменение радиуса основания.  

1. Перемещайте курсор при отпущенной кнопке мыши вверх или вниз, 

задавая тем самым высоту цилиндра. Кликните мышкой для фиксации 

высоты. После щелчка мыши, фиксирующего высоту, передвиньте курсор 

еще на некоторое расстояние вверх и щелкните еще раз. Расстояние, 

которое вы отмерили сейчас, будет равно ширине фаски, срезаемой под 

углом в 45°.  

2. Задайте значения следующих параметров в свитке Parameters (Параметры): 

• Height (Высота) – высота цилиндра; 

• Height Segments (Сегментов по высоте) – количество сегментов 

поверхности; 

• Сар Segments (Колец основания) – количество сегментов по радиусу; 



 

• Fillet (Фаска) – величина фаски; 

• Fillet Segs (Сегментов по фаске) – число сегментов по фаске.   

3. Закройте программу 3ds MAX без сохранения файла. 

 

Практическая  работа №8 Работа с примитивами: 

выравнивание, перемещение, вращение, клонирование, группировка 

(часть 1)  

 

Цель и содержание работы 

Цель работы – научиться создавать сложные составные объекты, 

используя стандартные примитивы. В процессе выполнения лабораторной 

работы вы закрепите навыки по созданию стандартных примитивов, научитесь 

устанавливать настройки объектов, выделять объекты и выравнивать их 

относительно друг друга по осям X, Y и Z, клонировать и группировать 

объекты, выполнять операцию Rotate (Вращение), выполнять операцию Move 

(Перемещение).  

Теоретическое обоснование 

Если вы собираетесь стать профессионалом в разработке трехмерной 

графики, вы должны научиться видеть простое в сложном. Например, если вы 

собираетесь моделировать сложный объект, внимательно проанализируйте его 

геометрию. Если она будет иметь правильные очертания, это будет означать, 

что для создания трехмерной модели можно использовать стандартные 

объекты-примитивы.  

Такой метод моделирования быстр и несложен, а кроме того, позволяет 

использовать в сценах оптимально низкое количество полигонов. Последний 

фактор особенно важен, если разрабатываемая сцена содержит большое 

количество объектов.  

На рис. 1 показано, что можно сделать с помощью простейших объектов. 

Возможно, в это трудно поверить, но в этой сцене использовались только 

стандартные примитивы 3ds MAX.  



 

 

Рис. 1 – Сцена, созданная с использованием только стандартных примитивов  

Рассмотрим ее создание подробно. Смоделировав подобную сцену, вы 

научитесь создавать объекты и производить с ними основные операции: 

выравнивание, перемещение, вращение, клонирование, группировку. 

 Методика и порядок выполнения работы 

Задание. Создание чашек 

Трехмерная модель чашки будет состоять из одного объекта Tube (Трубка), 

одного примитива Cylinder (Цилиндр) и трех примитивов Torus (Top).  

1. Для создания объекта Tube (Трубка) сделайте следующее. Перейдите на 

вкладку Create (Создание) командной панели. Выберите категорию 

Geometry (Геометрия).  

2. Из раскрывающегося списка выберите группу Standard Primitives 

(Простые примитивы). Нажмите кнопку с названием примитива Tube 

(Трубка). 

3. Кликните мышью в любом месте окна проекции и, не отпуская кнопку, 

изменяйте положение указателя мыши до тех пор, пока объект в окне не 

достигнет нужного размера. Отпустите кнопку мыши (рис.2). 



 

 

Рис. 2 – Объект Tube (Трубка) в окнах 

проекций 

4. Задайте параметры объекта. Для этого 

перейдите на вкладку Modify 

(Изменение) командной панели. 

Установите следующие параметры: Radius 

1 (Радиус 1) – 100, Radius 2 (Радиус 2) – 

95. Height (Высота) – 230, Height Segments 

(Количество сегментов по высоте) – 8, Cap 

Segments (Количество сегментов в 

основании) – 5, Sides (Количество сторон) 

– 30. Чтобы объект принял сглаженную 

форму, установите флажок Smooth 

(Сглаживание), (рис. 3). 

5. Теперь аналогичным образом создайте в 

окне проекции объект Torus (Top). Затем 

перейдите на вкладку Modify 

Рис. 3 – Параметры объекта 

Tube (Трубка)  



 

(Изменение) командной панели и установите для объекта следующие 

параметры: Radius 1 (Радиус 1) – 95, Radius 2 (Радиус 2) – 6, Rotation 

(Вращение) – 0, Twist (Скручивание) – 0, Segments (Количество сегментов) 

– 65, Sides (Количество сторон) – 21. Чтобы объект принял сглаженную 

форму, установите переключатель Smooth (Сглаживание.  

 

6. Выровняйте созданные объекты относительно друг друга таким образом, 

чтобы Torus (Top) был расположен на торце объекта Tube (Трубка). Для 

выравнивания выделите объект Torus (Top), кликнув на нем мышью.  

7. Выполните команду Tools → Align (Инструменты → Выравнивание). 

При этом курсор изменит форму. Кликните на объекте Tube (Трубка).  

8. На экране появится окно Align Selection (Выравнивание выделенных 

объектов), в котором необходимо указать, по какому принципу будет 

происходить выравнивание. Установите флажок Z Position (Z-позиция). 

Установите переключатель Current Object (Объект, который 

выравнивается) в положение Center (По центру). Установите 

переключатель Target Object (Объект, относительно которого 

выравнивается) в положение Maximum (По максимальным 

координатам выбранных осей), (рис. 5).  

 



 

Рис. 5 – Настройки выравнивания объектов по оси Z  

9. Нажмите кнопку Apply (Применить). Объект Torus (Top) изменит свое 

положение относительно объекта Tube (Трубка) по оси Z таким образом, 

что центр объекта Torus (Top) совпадет с верхним краем объекта Tube 

(Трубка), (рис. 6).  

10. Теперь необходимо выровнять объекты по осям X и Y. Установите флажки 

Y Position (Y-позиция) и X Position (Х-позиция). Установите 

переключатель Current Object (Объект, который выравнивается) в 

положение Center (По центру).  

 

Установите переключатель Target Object (Объект, относительно которого 

выравнивается) в положение Center (По центру). Нажмите кнопку Apply 

(Применить) или ОК (рис. 7).  

 

11. В результате выравнивания объектов мы получили чашку с закругленным 

верхним краем. Сделаем для нее основание. Для этого можно использовать 

созданный объект Torus (Top). Выделите объект, щелкнув на нем мышью, 

и выполните команду Edit → Clone (Правка → Клонировать).  

12. В появившемся окне Clone Options (Параметры клонирования), (рис. 8) 

выберите вариант клонирования Сору (Независимая копия объекта). 

При этом будет создан еще один объект Torus (Top), который вы не 



 

увидите, так как он будет иметь аналогичные исходному объекту размеры 

и будет занимать такое же положение.  

 

 

 

 

 

 

13. Выровняем полученную копию (объект Torus02) относительно объекта 

Tube (Трубка). Для этого вызовите уже известное вам окно Align Selection 

(Выравнивание выделенных объектов). Поскольку положение 

созданного объекта совпадает с первым тором, выравнивать его нужно 

только вдоль оси Z. Установите в окне Align (Выравнивание) следующие 

параметры: флажокZ Position (Z-позиция), переключатель Current Object 

(Объект, который выравнивается) в положение Center (По центру), 

переключатель Target Object (Объект, относительно которого 

выравнивается) в положение Minimum (По минимальным координатам 

выбранных осей). Нажмите кнопку Apply (Применить) или ОК.  

14. Чтобы придать чашке устойчивость, необходимо сделать ее основу более 

толстой. Убедитесь, что выделен объект Torus02, перейдите на вкладку 

Modify (Изменение) и измените значение параметра Radius 2 (Радиус 2)  

на 16. Вы получите изображение, показанное на рис. 9.  

Рис. 8 – Диалоговое окно Clone Options      

(Параметры клонирования) 

 



 

 

Рис. 9 – Чашка почти готова  

15. Теперь чашке необходимо сделать ручку. Ее также можно создать при 

помощи примитива Torus (Top). Выделите первый тор, щелкнув на нем 

мышью, и выполните команду Edit → Clone (Правка → Клонировать).  

16. В появившемся окне Clone Options (Параметры клонирования) 

выберите вариант клонирования Сору (Независимая копия объекта). 

При этом будет создан третий объект Torus (Top), который вы не увидите, 

так как он будет иметь аналогичные исходному объекту размеры и будет 

занимать такое же положение.  

17. Выровняем полученную копию (объект Torus03) относительно объекта 

Tube (Трубка). Для этого вызовите окно Align Selection (Выравнивание 

выделенных объектов). Сначала выровняем его по оси Z. Установите в 

окне Align Selection (Выравнивание выделенных объектов) следующие 

параметры: флажок Z Position (Z-позиция), переключатель Current Object 

(Объект, который выравнивается) и переключатель Target Object (Объект, 

относительно которого выравнивается) в положение Center (По центру). 



 

Нажмите кнопку Apply (Применить). При этом третий тор (объект 

Torus03) будет размещен в середине чашки.  

18. Кликните на объекте Torus03 правой кнопкой мыши и выберите в 

контекстном меню команду Rotate (Вращение). При этом на месте 

координатных осей локальной системы координат появится схематическое 

отображение возможных направлений поворота объекта. Если подвести 

указатель к каждому из направлений, то схематическая линия подсветится 

желтым цветом. Это означает, что поворот будет произведен в данном 

направлении. Поверните объект по оси Y на 90°, (рис. 10). 

19. Теперь выровняем объект Torus03 по оси Y относительно объекта Tube 

(Труба). Для этого в окне Align Selection (Выравнивание выделенных 

объектов) установите следующие параметры: флажок Y Position (Y-

позиция), переключатель Current Object (Объект, который 

выравнивается) в положение Maximum (по максимальным координатам 

выбранных осей), переключатель Target Object (Объект, относительно 

которого выравнивается) в положение Center (По центру). Нажмите 

кнопку Apply (Применить), (рис. 11).  

 

 
Рис. 10 – Вращение объекта  



 

 

Рис. 11 – Вид объектов после выравнивания  

Удалить часть тора, которая оказалась внутри чашки. Для этого убедитесь, 

что объект выделен, перейдите на вкладку Modify (Изменение) командной 

панели и в настройках объекта установите флажок Slice On (Удалить). В 

результате этого тор станет разомкнутым и появится возможность ограничить 

его размеры.  Установите значение параметра Slice From (Удалить от) равным 

-89, а параметра Slice То (Удалить до) — 89. Уменьшите значение параметра 

Radius 1 (Радиус 1) до 65, а значение Radius 2 (Радиус 2) увеличьте до 8. 

20. Создание дна чашки. Для этого создайте в окне проекции стандартный 

примитив Cylinder (Цилиндр) так, как это описано выше, и установите 

для него следующие параметры: Radius (Радиус) – 100, Height (Высота) – 

10, Height Segments (Количество сегментов по высоте) – 5, Cap Segments 

(Количество сегментов в основании) – 1, Sides (Количество сторон) – 30. 

Чтобы объект принял сглаженную форму, установите флажок Smooth 



 

(Сглаживание). Выровняйте созданный объект относительно основания 

чашки, которым служит объект Tube (Трубка). Чашка готова (рис. 12).  

 

Рис. 12 – Готовая модель чашки  

21. Чашка состоит из пяти объектов, поэтому, чтобы в дальнейшем легче было 

работать с чашкой как целым объектом, необходимо сгруппировать 

составные объекты. Для этого воспользуйтесь сочетанием клавиш Ctrl+A, 

чтобы выделить все объекты в сцене, и выполните команду Group → 

Group (Группировать → Группировка). В диалоговом окне Group 

(Группировка) укажите название группы в поле Group name (Название 

группы), например Чашка, и нажмите ОК.  

 

 



 

Практическая  работа №9 Работа с примитивами: 

выравнивание, перемещение, вращение, клонирование, группировка 

(часть 2) 

 

Цель и содержание работы 

Цель работы – научиться создавать сложные составные объекты, 

используя стандартные примитивы. В процессе выполнения лабораторной 

работы вы закрепите навыки по созданию стандартных примитивов, научитесь 

устанавливать настройки объектов, выделять объекты и выравнивать их 

относительно друг друга по осям X, Y и Z, клонировать и группировать 

объекты, выполнять операцию Rotate (Вращение), выполнять операцию Move 

(Перемещение).  

Теоретическое обоснование 

Если вы собираетесь стать профессионалом в разработке трехмерной 

графики, вы должны научиться видеть простое в сложном. Например, если вы 

собираетесь моделировать сложный объект, внимательно проанализируйте его 

геометрию. Если она будет иметь правильные очертания, это будет означать, 

что для создания трехмерной модели можно использовать стандартные 

объекты-примитивы.  

Такой метод моделирования быстр и несложен, а кроме того, позволяет 

использовать в сценах оптимально низкое количество полигонов. Последний 

фактор особенно важен, если разрабатываемая сцена содержит большое 

количество объектов.  

 

Задание. Создание полки 

1. Для моделирования полки для посуды подойдет стандартный примитив 

Box (Параллелепипед). Для его создания перейдите на вкладку Create 

(Создание) командной панели и выберите категорию Geometry 

(Геометрия). Из раскрывшегося списка в группе Standard Primitives 



 

(Простые примитивы) нажмите кнопку Box (Параллелепипед). 

Кликните в любом месте окна проекции и, не отпуская кнопку, изменяйте 

положение указателя мыши до тех пор, пока объект в окне не достигнет 

необходимого размера, затем отпустите кнопку мыши.  

2. Теперь необходимо задать параметры объекта. Для этого перейдите на 

вкладку Modify (Изменение) командной панели. Установите для объекта 

следующие параметры: Length (Длина) – 445, Width (Ширина) – 1870, 

Height (Высота) – 18. 

3. Выделите созданный примитив и выровняйте его относительно чашки. Для 

этого в окне Align Selection (Выравнивание выделенных объектов) 

установите следующие параметры: флажок Z Position (Z-позиция), 

переключатель Current Object (Объект, который выравнивается) в 

положение Maximum (По максимальным координатам выбранных осей), 

переключатель Target Object (Объект, относительно которого 

выравнивается) в положение Minimum (По минимальным координатам 

выбранных осей). Нажмите кнопку Apply (Применить). 

Примечание: при выравнивании обычного объекта относительно 

сгруппированного необходимо кликать на том элементе группы, относительно 

которого нужно выровнять. В нашем случае — это основание чашки (объект 

Torus02).  

4. Выделите объект Box (Параллелепипед) и щелкните на нем правой 

кнопкой мыши. Выберите в контекстном меню команду Move 

(Перемещение) и подведите указатель к одной из осей — X или Y. 

Перемещая объект вдоль выбранной оси, добейтесь, чтобы чашка была 

расположена так, как показано на рис. 13.  



 

 

Рис. 13 – Расположение объектов в сцене  

5. Теперь создадим копию объекта Box (Параллелепипед). Выделите объект, 

щелкпув на нем мышью, и выполните команду Edit → Clone (Правка → 

Клонировать). В появившемся окне Clone Options (Параметры 

клонирования) выберите вариант клонирования Сору (Независимая копия 

объекта). Кликните на созданном объекте правой кнопкой мыши и 

выберите в контекстном меню команду Rotate (Вращение) и поверните 

объект по оси X на 90°, (рис. 14).  



 

 

Рис. 14 – Выполнение операции Rotate (Вращение) 

6. Выровняйте объект Вох02 относительно первого параллелепипеда. На 

этом создание полки можно считать завершенным (рис. 15).  

 

Рис. 14 – Полка для посуды с чашкой 

 



 

Практическая работа №10 Работа с примитивами: 

выравнивание, перемещение, вращение, клонирование, группировка 

(часть 3) 

 

Цель и содержание работы 

Цель работы – научиться создавать сложные составные объекты, 

используя стандартные примитивы. В процессе выполнения лабораторной 

работы вы закрепите навыки по созданию стандартных примитивов, научитесь 

устанавливать настройки объектов, выделять объекты и выравнивать их 

относительно друг друга по осям X, Y и Z, клонировать и группировать 

объекты, выполнять операцию Rotate (Вращение), выполнять операцию Move 

(Перемещение).  

Теоретическое обоснование 

Если вы собираетесь стать профессионалом в разработке трехмерной 

графики, вы должны научиться видеть простое в сложном. Например, если вы 

собираетесь моделировать сложный объект, внимательно проанализируйте его 

геометрию. Если она будет иметь правильные очертания, это будет означать, 

что для создания трехмерной модели можно использовать стандартные 

объекты-примитивы.  

Такой метод моделирования быстр и несложен, а кроме того, позволяет 

использовать в сценах оптимально низкое количество полигонов. Последний 

фактор особенно важен, если разрабатываемая сцена содержит большое 

количество объектов.  

 

 

Задание. Создание подставки для тарелок 

1. Создайте объект Torus (Top) в окне проекции, перейдите на вкладку 

Modify (Изменение) командной панели. Установите для объекта 

следующие параметры: Radius 1 (Радиус 1) — 348, Radius 2 (Радиус 2) — 5, 



 

Rotation (Вращение) — 0, Twist (Скручивание) — 0, Segments (Количество 

сегментов) — 32, Sides (Количество сторон) — 9. Чтобы объект принял 

сглаженную форму, установите флажок Smooth (Сглаживание). Как вы 

видите, созданный объект расположен не так, как надо (рис. 15). 

 

Рис. 15 – Новый объект Torus (Top) в сцене  

2. Щелкните на созданном объекте правой кнопкой мыши и выберите в 

контекстном меню команду Rotate (Вращение). Поверните объект вдоль 

оси X или Y (это зависит от того, как у вас расположена полка в окне 

проекций) таким образом, чтобы он располагался перпендикулярно 

объектам Box01 и Вох02. Выровняйте положение тора относительно 

объекта Вох02 так, как показано на рисунке 16. 



 

 

Рис. 16 – Расположение объектов в сцене после выравнивания 

3. Удалите часть тора, которая оказалась за полкой. Установите значение 

параметра Slice From (Удалить от) равным  -180, а параметра Slice To 

(Удалить до) — 90 (рис. 17).  

 

Рис. 17 – Сцена после удаления ненужной части тора 



 

4. Создадайте копию тора, для чего, выделив объект, выполните команду 

Edit → Clone (Правка → Клонировать). В появившемся окне Clone 

Options (Параметры клонирования) выберите вариант клонирования 

Сору (Независимая копия объекта).  

5. Щелкните на созданном объекте правой кнопкой мыши. Выберите в 

контекстном меню команду Move (Перемещение) и передвиньте объект 

вдоль полки.  

6. Нажав и удерживая клавишу Ctrl, щелкните на обоих объектах (исходном) 

и полученному) — объекты выделятся. Еще раз выполните команду Edit 

→ Clone (Правка → Клонировать). В появившемся окне Clone Options 

(Параметры клонирования) выберите вариант клонирования Сору 

(Независимая копия объекта). Переместите полученные объекты вдоль 

полки. Повторите клонирование еще раз и создайте третью пару объектов. 

Переместите их вдоль полки. Подставка для тарелок готова (рис. 18). 

 

Рис. 18 – Сцена после создания подставки для тарелок  



 

 

Задание. Создание тарелок 

1. Создайте примитив Cone (Конус). Перейдите на вкладку Modify 

(Изменение) командной панели и установите для него следующие 

параметры: Radius 1 (Радиус 1) — 206, Radius 2 (Радиус 2) — 159, Height 

(Высота) — 57, Height Segments (Количество сегментов но высоте) — 5, 

Сар Segments (Количество сегментов в основании) — 1, Sides (Количество 

сторон) — 80. Чтобы объект принял сглаженную форму, установите 

флажок Smooth (Сглаживание).  

2. Выровняйте полученный объект относительно полки для посуды так, как 

показано на рис. 19.  

 

Рис. 19 – Сцена после вставки тарелки в подставку  

3. Создайте еще одну тарелку, выполнив команду Edit → Clone (Правка → 

Клонировать). В появившемся окне Clone Options (Параметры 

клонирования) выберите вариант клонирования Сору (Независимая копия 

объекта).  



 

Примечание: конечно, созданные таким образом тарелки будут похожи на 

настоящие, только если смотреть на них под определенным углом. В этом 

заключается одна из хитростей трехмерной графики. Моделировать объект 

следует только той стороной, которая будет видна зрителю. В нашем 

примере тарелки выгнуты с одной стороны (с той, которая обращена к 

зрителю), но не вогнуты с другой.  

4. Выровняйте созданный объект относительно подставки, а именно слева 

относительно четвертого объекта Torus (Top). Получились две тарелки в 

подставке (рис. 20).  

 

Рис. 20 – Сцена с двумя тарелками в подставке  

 

 

Задание. Создание граненого стакана 

1. Для создания стакана подойдет примитив Tube (Трубка). Создав объект, 

перейдите на вкладку Modify (Изменение) командной панели и 

установите для него следующие параметры: Radius 1 (Радиус 1) — 100, 

Radius 2 (Радиус 2) — 90, Height (Высота) — 280, Height Segments 



 

(Количество сегментов по высоте) — 5, Cap Segments (Количество 

сегментов в основании) — 2, Sides (Количество сторон) — 11. Чтобы на 

объекте обозначились грани, снимите флажок Smooth (Сглаживание). 

2. Теперь создадим дно стакана. Для этого клонируйте имеющийся объект 

Tube (Трубка), выполнив команду Edit → Clone (Правка → 

Клонировать). В появившемся окне Clone Options (Параметры 

клонирования) выберите вариант клонирования Сору (Независимая копия 

объекта). Как вы уже знаете, клонированный объект будет обладать теми 

же параметрами, что и исходный.  

3. Перейдите на вкладку Modify (Изменение) командной панели и измените 

некоторые параметры нового объекта: Radius 2 (Радиус 2) – 0 (благодаря 

этому дно будет сплошное), Height (Высота) – -22, Height Segments 

(Количество сегментов по высоте) – 2. 

4. Сгруппируйте два созданных объекта, чтобы в дальнейшем можно было 

легко работать с ними. Для этого, выделив оба объекта, выполните 

команду Group → Group (Группировать → Группировка). В 

диалоговом окне Group (Группировка) укажите название группы в поле 

Group name (Название группы), например Стакан (рис. 21).  



 

 

Рис. 21 – Создание группы объектов Стакан  

5. Выровняйте полученную группу объектов относительно полки для посуды, 

а точнее, относительно объекта Box01. Для этого в окне Align Selection 

(Выравнивание выделенных объектов) установите следующие параметры: 

флажок Z Position (Z-позиция), переключатель Current Object (Объект, 

который выравнивается) в положение Minimum (По минимальным 

координатам выбранных осей), переключатель Target Object (Объект, 

относительно которого выравнивается) в положение Maximum (По 

максимальным координатам выбранных осей).  

6. Выделите группу объектов Стакан и щелкните на ней правой кнопкой 

мыши. Выберите в контекстном меню команду Move (Переместить) и 

подведите указатель к одной из осей — X пли Y. Перемещая объект вдоль 

выбранной оси, добейтесь, чтобы стакан был расположен так, как показано 

на рис. 22.  



 

 

Рис. 22 – Расположение стакана на полке для посуды  

 

 

Практическая  подготовка №1  Использование модификаторов: Bend 

(Изгиб), Lattice (Решетка) 

 

Цель и содержание работы 

Цель работы – изучить принципы работы с модификаторами, научиться их  

применять и редактировать основные параметры. Данная Практическая работа 

содержит задания, выполнение которых поможет изучить и закрепить на 

практике принципы работы с модификаторами на примере применения 

некоторых деформирующих модификаторов. 

Теоретическое обоснование 

Модификатором называется действие, назначаемое объекту, в результате 

чего свойства объекта изменяются. Например, модификатор может действовать 

на объект, деформируя его различными способами — изгибая, вытягивая, 



 

Рис. 1 – Стек модификаторов 

скручивая и т.д. Модификатор также может служить для управления 

положением текстуры на объекте или изменять физические свойства объекта, 

например, делать его гибким.  

Важным элементом интерфейса 3ds MAX является Modifier Stack (Стек 

модификаторов) — список, расположенный на вкладке Modify (Изменение) 

командной панели (рис. 1).  

 

В этом списке отображается история 

применения некоторых инструментов (в том числе 

модификаторов) к выделенному объекту, а также 

представлены режимы редактирования подобъектов.  

 

 

Стек модификаторов очень удобен, так как 

содержит полную историю трансформации объектов 

сцены. При помощи стека модификаторов можно 

быстро перейти к застройкам самого объекта и 

примененных к нему модификаторов, отключить 

действие модификаторов или поменять местами 

очередность их воздействия на объект. При 

выделении объекта или примененной к нему 

команды его параметры появляются на вкладке 

Modify (Изменение) командной панели под стеком 

модификаторов (рис. 2). 



 

Рис. 2 – Параметры объекта Box (Параллелепипед) на вкладке Modify 

(Изменение) под стеком модификаторов 

Рис. 3 – Пункт Modifiers (Модификаторы)  главного меню 

Рис. 4 – Удаление модификатора из стека 

Рис. 5 – Стек модификаторов с выключенным 

модификатором Bend (Изгиб) 

 

Чтобы применить к объекту модификатор, нужно 

выделить объект и выбрать модификатор из списка Modifier 

List (Список модификаторов) на вкладке Modify 

(Изменение) командной панели. При этом название 

модификатора сразу появится в стеке. Назначить 

модификатор объекту можно также, воспользовавшись 

пунктом главного меню Modifiers (Модификаторы) (рис. 3). 

 

 

 

 

 

Для удаления назначенного модификатора 

необходимо выделить его название в стеке 

модификаторов и нажать кнопку Remove modifier from 

the stack (Удалить модификатор из стека), 

расположенную под окном стека модификаторов (рис. 

4). 

 

 

Действие модификатора можно приостановить. 

Эта возможность может пригодиться, когда 

необходимо проследить изменение объекта на разных 

этапах моделирования.  

Для выключения действия модификатора достаточно 



 

щелкнуть на пиктограмме в виде лампочки, которая расположена слева от 

названия модификатора в стеке (рис. 5).  

 

Список модификаторов очень длинный, и нет смысла перечислять все 

функции каждого из них, поэтому рассмотрим лишь наиболее используемые 

модификаторы,  а именно  деформирующие модификаторы. 

Основные модификаторы, деформирующие объект, называются 

параметрические модификаторы (Parametric Modifiers). С помощью таких 

модификаторов можно деформировать объект самыми различными способами. 

К деформирующим модификаторам также относятся модификаторы 

свободных деформаций (Free Form Deformers). Каждый из параметрических 

модификаторов содержит два режима редактирования подобъектов. 

Управление положением габаритного контейнера модификатора 

осуществляется при помощи параметра Gizmo (Гизмо). Задание центра 

применения модификатора — Center (Центр). Переключиться в один из этих 

режимов можно, раскрыв список модификаторов в стеке модификаторов и 

выделив требуемый режим. В каждом из этих режимов можно изменять 

положение габаритного контейнера и центральной точки эффекта. 

Методика и порядок выполнения работы 

Задание. Изучение модификатора Bend (Изгиб) 

Назначение данного модификатора — деформировать объект (рис. 6), 

сгибая его оболочку под определенным углом Angle (Угол) относительно 

некоторой оси Bend Axis (Ось изгиба). Этот модификатор, как и многие 

другие, имеет на свитке Parameters (Параметры) область Limits (Пределы), с 

помощью параметров которой можно определить границы применения 

модификатора, (рис. 7).  



 

 

Рис. 6 – Примеры использования модификатора Bend (Изгиб) 

 

Рис. 7 – Настройки модификатора Bend (Изгиб) 

1. Создайте объект Teapot (Чайник) и примените 

к нему модификатор Bend (Изгиб). 

2. Раскрыв список модификатора, выделите 

режим Gizmo (Гизмо) и измените объект, 

согнув его. 

3. Выделите режим Center (Центр) и, изменяя 

расположение центра применения 

модификатора, изучите принцип деформации 

объекта. 

Задание 2. Изучение модификатора Lattice 

(Решетка) 

Этот модификатор создает на поверхности объекта решетку на 

полигональной основе (рис. 8).  



 

 

Рис. 8 – Примеры использования модификатора 

Lattice (Решетка) 

В тех местах, где присутствуют ребра объекта, 

модификатор создает решетку, а на месте вершин 

устанавливает ее узлы.  В настройках модификатора 

(рис. 9) можно указать размер решетки при помощи 

параметра Radius (Радиус), количество сегментов — 

Segments (Количество сегментов) и сторон решетки 

— Sides (Стороны).  

При построении решетчатой структуры могут 

быть задействованы: Struts Only From Edges 

(Только прутья решетки), Joints Only From 

Vertices (Только вершины) или и то, и другое — 

Both (Все).  

Узлы решетки могут быть трех типов: Tetra 

(Тетраэдр), Octa (Октаэдр) и Icosa (Икосаэдр).  

Для узлов можно также определить величину — 

Radius (Радиус) и количество сегментов — Segments 

(Количество сегментов).  



 

Чтобы узлы и прутья решетки выглядели сглаженно, для каждого элемента 

(прутьев и вершин) предусмотрена возможность установить флажок Smooth 

(Сглаживание).  

 

Рис. 9 – Параметры модификатора Lattice (Решетка) 

1. Создайте объект Teapot (Чайник) и примените к нему модификатор Lattice 

(Решетка). 

2. Изменяя параметры деформации, изучите принцип действия 

модификатора.  

 

Практическая  подготовка №2  Использование модификаторов: Noise 

(Шум), Twist (Скручивание) 

   Цель и содержание работы 

Цель работы – изучить принципы работы с модификаторами, научиться их  

применять и редактировать основные параметры. Данная Практическая работа 

содержит задания, выполнение которых поможет изучить и закрепить на 

практике принципы работы с модификаторами на примере применения 

некоторых деформирующих модификаторов. 

     Теоретическое обоснование 

Модификатором называется действие, назначаемое объекту, в результате чего 

свойства объекта изменяются. Например, модификатор может действовать на 

объект, деформируя его различными способами — изгибая, вытягивая, 

скручивая и т.д. Модификатор также может служить для управления 

положением текстуры на объекте или изменять физические свойства объекта, 

например, делать его гибким.  



 

Важным элементом интерфейса 3ds MAX является Modifier Stack (Стек 

модификаторов) — список, расположенный на 

вкладке Modify (Изменение) командной панели 

(рис. 1).  

 

 

 

Методика и порядок выполнения работы: 

Задание 1. Изучение модификатора Noise (Шум) 

Этот модификатор имеет большое значение при моделировании природных 

ландшафтов. После воздействия данного модификатора на объект его 

поверхность становится зашумленной. Хаотическое искажение поверхности 

объекта может использоваться для создания любой неоднородной поверхности, 

например при имитации камня (рис. 10). 

 



 

Рис. 10 – Примеры использования модификатора Noise (Шум) 

Модификатор создает искажения объекта в одном из трех направлений — 

X, Y пли Z. Параметры, определяющие амплитуду воздействия вдоль каждой из 

осей, объединены в области Strength (Сила воздействия).  

Модификатор Noise (Шум) содержит параметр зашумления Fractal 

(Фрактальный), с помощью которого можно имитировать естественное 

зашумление объектов (горный ландшафт, мятую бумагу и др.). При 

установленном флажке Fractal (Фрактальный) становятся доступными два 

параметра зашумления — Roughness 

(Шероховатость) и Iterations (Количество 

итераций). Настройка Scale (Масштабирование) 

определяет масштаб зашумления, а величина Seed 

(Случайная выборка) служит для псевдослучайного 

создания эффекта (рис. 11). 

Рис. 11 – Настройки модификатора Noise (Шум) 

 

 

 

 

 

 

 

 

 



 

1. Создайте объект Teapot (Чайник) и примените к нему модификатор Noise 

(Шум). 

2. Изменяя параметры деформации, изучите принцип действия 

модификатора.  

Задание 2. Изучение модификатора Twist (Скручивание) 

В качестве примеров деформации кручения из реальной жизни можно 

привести сверло, серпантин, телефонный провод и т. д.  

Аналогичный вид можно придать трехмерным объектам 3ds MAX, 

применив модификатор Twist (Скручивание) (рис. 12).  

 

Рис. 12 – Примеры использования модификатора Twist (Скручивание) 

Модификатор имеет три основных параметра: Angle (Угол) — угол 

кручения, Bias (Наклон) — смещение эффекта и Twist Axis (Ось скручивания) 

— ось, определяющая направление действия модификатора (рис. 13). 



 

Рис. 13 – Настройки модификатора Twist (Скручивание) 

 

 

 

 

 

1. Создайте объект Teapot (Чайник) и примените к нему 

модификатор Noise (Шум). 

2. Изменяя параметры деформации, изучите принцип 

действия модификатора.  

 

Практическая  подготовка №3 Использование модификатора: FFD 4x4x4, 

Цель и содержание работы 

Цель работы – изучить принципы работы с модификаторами, научиться их  

применять и редактировать основные параметры. Данная Практическая работа 

содержит задания, выполнение которых поможет изучить и закрепить на 

практике принципы работы с модификаторами на примере применения 

некоторых деформирующих модификаторов. 

Теоретическое обоснование 

Модификатором называется действие, назначаемое объекту, в результате 

чего свойства объекта изменяются. Например, модификатор может действовать 

на объект, деформируя его различными способами — изгибая, вытягивая, 

скручивая и т.д. Модификатор также может служить для управления 

положением текстуры на объекте или изменять физические свойства объекта, 

например, делать его гибким. Важным элементом интерфейса 3ds MAX 

является Modifier Stack (Стек модификаторов) — список, расположенный на 

вкладке Modify (Изменение). 



 

Список модификаторов очень длинный, и нет смысла перечислять все 

функции каждого из них, поэтому рассмотрим лишь наиболее используемые 

модификаторы,  а именно  деформирующие модификаторы. 

Основные модификаторы, деформирующие объект, называются 

параметрические модификаторы (Parametric Modifiers). С помощью таких 

модификаторов можно деформировать объект самыми различными способами. 

К деформирующим модификаторам также относятся модификаторы 

свободных деформаций (Free Form Deformers). Каждый из параметрических 

модификаторов содержит два режима редактирования подобъектов. 

Управление положением габаритного контейнера модификатора 

осуществляется при помощи параметра Gizmo (Гизмо). Задание центра 

применения модификатора — Center (Центр). Переключиться в один из этих 

режимов можно, раскрыв список модификаторов в стеке модификаторов и 

выделив требуемый режим. В каждом из этих режимов можно изменять 

положение габаритного контейнера и центральной точки эффекта. 

Методика и порядок выполнения работы: 

Задание. Изучение модификаторов свободных деформаций 

Модификаторы свободных деформаций (FFD) воздействуют на объект по 

одному и тому же принципу. После назначения любого из них вокруг объекта 

возникает решетка с ключевыми точками (рис. 14).  



 

 

Рис. 14 – Применение к объекту модификатора FFD 4x4x4 

Эти точки привязываются к геометрическим характеристикам объекта, и 

при изменении положения любой из них объект деформируется.  

Чтобы осуществить редактирование объекта при помощи модификаторов 

свободной деформации, необходимо развернуть список в стеке модификаторов 

(щелкнув на плюсике рядом с названием модификатора) и переключиться в 

режим редактирования Control Points (Ключевые точки).  

Находясь в этом режиме, можно изменять положение ключевых точек, 

деформируя поверхность объекта. 

1. Создайте объект Teapot (Чайник) и примените к нему модификатор 

свободных деформаций FFD 4x4x4. 

2. Изменяя положение ключевых точек, изучите принцип действия 

модификатора.  

 



 

Практическая подготовка №4 Сплайновое моделирование 

 

Цель и содержание работы 

Цель работы – научиться моделировать объекты на основе сплайнов. 

Данная Практическая работа содержит задания, выполнение которых поможет 

изучить на практике принципы работы с трехмерными кривыми, а также 

закрепить навыки работы со стандартными примитивами и применения 

модификаторов к объектам. 

Теоретическое обоснование 

Один из эффективных способов создания трехмерных моделей — 

использование техники сплайнового моделирования. В конечном итоге 

создание модели при помощи сплайнов (трехмерных кривых) сводится к 

построению сплайнового каркаса, на основе которого создается огибающая 

трехмерная геометрическая поверхность.  

Сплайновые примитивы 

Сплайновые примитивы представляют собой такой же рабочий материал, 

как и простейшие трехмерные объекты, создаваемые в 3ds MAX. Сплайновый 

инструментарий программы включает в себя следующие фигуры (рис. 1):  



 

 

Рис. 1 – Сплайновые формы 

• Line (Линия);  

• Circle (Окружность);  

• Arc (Дуга);  

• NGon (Многоугольник);  

• Text (Сплайновый текст);  

• Section (Сечение);  

• Rectangle (Прямоугольник);  

• Ellipse (Эллипс);  

• Donut (Кольцо);  

• Star (Многоугольник в виде 

звезды);  

• Helix (Спираль).  

 

Чтобы создать сплайновый объект, 

перейдите на вкладку Create (Создание) 

командной панели в категорию Shapes 

(Формы), выберите строку Splines (Сплайны) и 

нажмите кнопку создаваемого примитива.  

Все сплайновые примитивы имеют схожие 

настройки. Например, каждый описанный 



 

объект имеет два обязательных свитка настроек: Rendering (Визуализация) и 

Interpolation (Интерполяция) (рис. 2). 

 

 

 

 

 

По умолчанию сплайновые примитивы не отображаются на этапе 

визуализации и используются как вспомогательные объекты для создания 

моделей со сложной геометрией. Однако любой сплайновый примитив может 

выступать в сцене как самостоятельный объект. За отображение объекта в окне 

проекции и на этапе визуализации отвечает свиток настроек Rendering 

(Визуализация). Если установить флажок Renderable (Визуализируемый), 

объект на этапе визуализации становится видимым. Включенный параметр 

Display Render Mesh (Показывать сетку визуализации) позволяет 

визуализировать сплайновый примитив в окне проекции с учетом толщины 

сплайна, которая регулируется параметром Thickness (Толщина). Создаваемый 

сплайн характеризуется также количеством сторон Sides (Количество сторон) и 

углом их расположения Angle (Угол). Минимальное количество сторон сплайна 

— 3 (такой сплайн имеет треугольное сечение). Свиток настроек Interpolation 

(Интерполяция) определяет количество шагов интерполяции сплайна 

(количество сегментов между вершинами объекта). Установленный флажок 

Optimize (Оптимизация) служит для оптимизации сплайна. 

Редактирование сплайнов 

Любой сплайновый примитив можно преобразовать в так называемый 

Editable Spline (Редактируемый сплайн), который позволяет изменять форму 

объектов. В отличие от всех сплайновых примитивов, объект Line (Линия) по 

Рис. 2 – Два общих свитка настроек всех  

сплайновых примитивов 

 



 

умолчанию обладает всеми свойствами редактируемого сплайна, поэтому 

конвертировать его в редактируемый сплайн не имеет смысла.  

Для преобразования сплайна в редактируемый щелкните на нем правой 

кнопкой мыши и в появившемся контекстном меню выберите команду Convert 

To → Convert to Editable Spline (Преобразовать → Преобразовать в 

редактируемый сплайн) (рис. 3).  

 

Рис. 3 – Открытие подменю Convert То 

(Преобразовать) 

Форма сплайнового объекта, преобразованного 

в редактируемый сплайн, может быть 

откорректирована на следующих уровнях 

подобъектов: Vertex (Вершина), Segments 

(Сегменты) и Spline (Сплайн). Для перехода в один 

из этих режимов редактирования выделите объект, 



 

перейдите на вкладку Modify (Изменение) командной панели и, развернув 

список в стеке модификаторов, переключитесь в нужный режим 

редактирования. Переключаться между режимами редактирования можно при 

помощи кнопок в свитке Selection (Выделение), который присутствует в 

каждом режиме (рис. 4). 

 

 

 

 

 

 

 

Рис. 4 – Свиток настроек Selection (Выделение) 

Редактируемый сплайн имеет большое количество настроек, которые 

позволяют вносить любые изменения в структуру объекта. Например, при 

помощи кнопки Attach (Присоединить) в свитке Geometry (Геометрия) 

настроек объекта вы можете присоединить к данному объекту любой другой, 

имеющийся в сцене. В режиме редактирования подобъектов Vertex (Вершина) 

можно изменить характер поведения кривой в точках изломов. Точки излома — 

это участки, в которых кривая изгибается. Они могут выглядеть по-разному: в 

виде острых углов или закругленных участков. Чтобы изменить характер 

излома в настройках режима редактирования Vertex (Вершина), установите 

переключатель New Vertex Type (Тип излома вершины) в одно из положений: 

Linear (Прямой), Bezier (Безье), Smooth (Сглаженный) или Bezier Corner (Угол 

Безье). Тип излома вершин можно также изменить при помощи контекстного 



 

меню. Для этого нужно выделить необходимые вершины, щелкнуть правой 

кнопкой мыши в окне проекции и выбрать характер излома.  

В зависимости от характера излома выделенные вершины по-разному 

отображаются в окне проекции — вершины типов Bezier (Безье) и Bezier Corner 

(Угол Безье) имеют специальные маркеры, с помощью которых можно 

управлять формой искривления.  

Методика и порядок выполнения работы 

Поскольку в основе каждой трехмерной поверхности лежит сетчатая 

оболочка, моделирование при помощи трехмерных кривых позволяет 

имитировать любую форму объекта. Вместе с этим сплайновые объекты могут 

выступать в роли вспомогательных инструментов для описания геометрии тела. 

Рассмотрим простой пример использования техники сплайнового 

моделирования для создания модели консервного ножа (рис. 5).  

 

Рис. 5 – Модель консервного ножа, созданная при помощи трехмерных кривых 

Конечная модель должна состоять из четырех элементов, каждый из 

которых создадим при помощи сплайнов. 



 

Задание 1. Создание первого элемента 

1. Переключитесь в окно проекции Тор (Сверху) и с помощью инструмента 

Line (Линия) несколькими щелчками мыши создайте кривую, показанную 

на рис. 6. Обратите внимание, что нужно создать замкнутый сплайн, то 

есть последняя вершина кривой должна совпасть с начальной. Для этого 

необходимо сделать последний щелчок мыши на первой вершине и в 

появившемся окне Spline (Сплайн) (рис. 7) утвердительно ответить на 

вопрос, нажав Да. 

 

Рис. 6 – Элемент консервного ножа, созданный при помощи 

инструмента  Line (Линия) 

2. Результат, который вы при этом получите, будет далек от идеального. В 

отличие от полученной, искомая кривая должна иметь различные типы 

излома в точках изгиба: на предполагаемых остриях излом должен быть 

линейным, а во всех других точках — плавным. Чтобы исправить 

ситуацию, необходимо вручную установить тип излома в каждой точке. 

Для этого выделите объект в окне проекции Тор (Сверху), после чего 



 

перейдите на вкладку Modify (Изменение) командной панели. Раскройте 

строку Line (Линия) в стеке модификаторов, щелкнув на значке плюс. 

Переключитесь в режим редактирования Vertex (Вершина) (рис. 8).  

 

Рис. 8 – Режим редактирования Vertex (Вершина) объекта Line (Линия) 

В окне проекции выделите одну или несколько вершин объекта, в которых 

вам необходимо изменить характер излома. Для выделения нескольких 

вершин нажмите и удерживайте клавишу Ctrl. Для изменения характера 

излома выделенных вершин щелкните правой кнопкой мыши в окне 

проекции и в контекстном меню выберите требуемый тип излома, 

например Smooth (Сглаженный) (рис. 9).  



 

 

Рис. 9 – Выбор характера излома в контекстном меню 

 

Рис. 10 – Вид сплайна после изменения характера излома вершин 

Тип излома Corner (Угол) должны иметь только те вершины, которые 

расположены на торцах консервного ножа, остальным вершинам нужно 

присвоить Smooth (Сглаженный) или Bezier Corner (Угол Безье), (рис. 10). 

Для улучшения формы сплайна для некоторых вершин нужно будет не 

только изменить характер излома, но и переместить их. 



 

3. Теперь необходимо выполнить операцию Extrude (Выдавливание). После 

использования одноименного модификатора будет создана трехмерная 

поверхность с сечением созданного сплайна. Выделите объект в окне 

проекции, перейдите на вкладку Modify (Изменение) командной панели, 

раскройте список Modifier List (Список модификаторов) и выберите в 

нем модификатор Extrude (Выдавливание). В настройках модификатора 

укажите следующие значения параметров: Amount (Величина) — 4,5, 

Segments (Количество сегментов) — 3. Установите переключатель Output 

(Результат) в положение Mesh (Поверхность). Чтобы объект стал 

сплошным, в области Capping (Настройки замкнутой поверхности) 

установите флажки Cap Start (Замкнутая поверхность в начале) и Cap End 

(Замкнутая поверхность в конце). После этого объект примет вид, 

показанный на рис. 11.  

 

Рис.11 – Вид объекта после выполнения операции выдавливания 

Задание 2. Создание второго элемента 

1. Для создания второго элемента перейдите в окно проекции Left (Слева) и 

создайте еще один объект Line (Линия) формы, показанной на рис. 12. 



 

При необходимости измените характер излома вершин так, как описано 

выше.  

 

Рис. 12 – Заготовка второго элемента консервного ножа 

2. При моделировании объектов посредством трехмерных кривых часто 

возникает необходимость выровнять какую-нибудь точку сплайна. 

Делается это аналогично выравниванию трехмерных объектов. В нашем 

случае необходимо выровнять крайние вершины кривой по одной 

координате Y. Для этого перейдите на вкладку Modify (Изменение) 

командной панели и раскройте список Line (Линия) в стеке 

модификаторов, щелкнув на значке «плюс». Переключитесь в режим 

редактирования Vertex (Вершина) и в окне проекции выделите крайнюю 

вершину объекта. Выполните команду Tools → Align (Инструменты → 

Выравнивание) и кликните в любом месте кривой. На экране появится 

окно Align Selection (Выравнивание выделенных объектов), в котором 

необходимо указать, по какому принципу будет происходить 

выравнивание. Обратите внимание, что переключатель Current Object 

(Объект, который выравнивается) будет неактивен (рис. 13). Такую 

ситуацию можно объяснить тем, что вершина, которая в данном случае 

является выравниваемым объектом, — это условный объект, не имеющий 



 

геометрических размеров. Именно поэтому нельзя указать его параметры. 

Установите флажок Y Position (Y-позиция). Установите переключатель 

Target Object (Объект, относительно которого выравнивается) в положение 

Minimum (По минимальным координатам выбранных осей) и нажмите 

кнопку ОК. 

 

Рис. 13 – Окно Align Sub-Object Selection (Выравнивание 

выделенных подобъектов) 

3. Теперь необходимо создать зеркальную копию созданного сплайна и 

совместить трехмерную кривую с ее копией. Для этого перейдите на 

вкладку Modify (Изменение) командной панели. Раскройте строку Line 

(Линия) в стеке модификаторов, щелкнув на значке плюса. 

Переключитесь в режим редактирования Spline (Сплайн) (рис. 14).  

 



 

 

Рис. 14 – Режим редактирования Spline (Сплайн) объекта Line (Линия) 

 

В свитке настроек Geometry (Геометрия) установите флажки Automatic 

Welding (Автоматически соединить) и Сору (Копировать). Выберите 

вариант Mirror Vertically (Отобразить вертикально) и нажмите кнопку 

Mirror (Зеркало) (рис. 15). 

 



 

 

Рис. 15 – Вид объекта после создания зеркальной копии 

Вы получите зеркальную копию сплайна, которую нужно переместить 

таким образом, чтобы вершины двух объектов совпали (рис. 16). Из-за 

того, что установлен флажок Automatic Welding (Автоматически 

соединить), вершины автоматически объединятся. 

 

Рис. 16 – Совмещение зеркальной копии и оригинала 

4. После выполнения этих действий получилась замкнутая кривая. Выйдите 

из режима редактирования Spline (Сплайн) и выделите весь объект. 

Выполните команду Edit → Clone (Правка → Клонировать). В 

появившемся окне Clone Options (Параметры клонирования) выберите 

вариант клонирования Сору (Независимая копия объекта). При этом 



 

клонированный объект будет обладать теми же параметрами, что и 

исходный.  

5. Кликните правой кнопкой мыши в окне проекции, выберите в контекстном 

меню команду Scale (Масштабирование) и увеличьте клонированный 

объект в плоскости XY (рис. 17).  

 

Рис. 17 – Вид объектов после выполнения операции Scale (Масштабирование) 

6. Выровняйте полученный объект относительно исходного. Для этого в окне 

Align Selection (Выравнивание выделенных объектов) выберите 

следующие параметры: установите флажок Y Position (Y-позиция), 

установите переключатель Current Object (Объект, который 

выравнивается) в положение Center (По центру), установите 

переключатель Target Object (Объект, относительно которого 

выравнивается) в положение Center (По центру). Нажмите кнопку Apply 

(Применить).  Установите переключатель Current Object (Объект, который 

выравнивается) в положение Pivot Point (Опорная точка). Установите 

переключатель Target Object (Объект, относительно которого 

выравнивается) в положение Center (По центру) и нажмите кнопку ОК 

(рис. 18).  



 

 

Рис. 18 – Вид объектов после выравнивания 

7. Выделите клонированный объект, перейдите на вкладку Modify 

(Изменение) командной панели. В свитке Geometry (Геометрия) настроек 

выделенного объекта нажмите кнопку Attach (Присоединить), чтобы 

присоединить к объекту исходный сплайн. Подведите указатель мыши к 

сплайну – указатель изменит свою форму (рис. 19) – и кликните на 

исходном объекте. 

 

Рис. 19 – Объединение сплайнов 



 

8. Теперь необходимо выполнить операцию Extrude (Выдавливание). После 

использования одноименного модификатора будет создана трехмерная 

поверхность с сечением созданного сплайна. Выделите объект в окне 

проекции, перейдите на вкладку Modify (Изменение) командной панели, 

раскройте список Modifier List (Список модификаторов) и выберите в 

нем модификатор Extrude (Выдавливание).  

В настройках модификатора укажите следующие значения: Amount 

(Величина) — 26, Segments (Количество сегментов) — 3. В области Output 

(Результат) настроек модификатора для итогового объекта выберите тип 

Mesh (Поверхность). Чтобы объект стал сплошным, в области Capping 

(Настройки замкнутой поверхности) установите флажки Cap Start 

(Замкнутая поверхность в начале) и Cap End (Замкнутая поверхность в 

конце). После этого объект примет вид, показанный на рис. 20.  

 

Рис. 20 – Вид объекта после выполнения операции Extrude (Выдавливание) 

 



 

Задание 3. Создание третьего элемента 

Третий элемент консервного ножа самый простой. Он соединяет ручку и 

металлическую основу, которую мы уже создали.  

1. Для создания этого элемента переключитесь в окно проекции Тор (Сверху) 

и с помощью инструмента Line (Линия) создайте кривую, показанную на 

рис. 21, таким образом, чтобы она начиналась с середины второго 

элемента консервного ножа и слегка выступала за его край с другой 

стороны. При необходимости измените характер излома вершин так, как 

описано выше.  

 

Рис. 21 – Создание третьего элемента консервного ножа 

2. Выделите созданный сплайн и перейдите на вкладку Modify (Изменение) 

командной панели. Раскройте список Modifier List (Список 

модификаторов) и выберите в нем модификатор Lathe (Вращение 

вокруг оси). Данный модификатор позволяет получить поверхность 

вращения с заданным сплайновым профилем.  

В свитке Parameters (Параметры) настроек модификатора Lathe 

(Вращение вокруг оси) (рис. 22) выберите ось, вокруг которой будет 

происходить вращение сплайна, нажав кнопку Y в области Direction 



 

(Направление). После этого в окне проекции сплайн превратится в фигуру 

вращения вокруг выбранной оси. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Полученная модель не совсем похожа на объект, который вам 

необходимо создать, усовершенствуйте его. Определите положение для 

оси вращения. Для этого в области Align (Выравнивание) настроек 

модификатора нажмите кнопку Min (Минимальный). Выбранная ранее ось 

вращения будет автоматически выровнена по краю модели. Выберите тип 

редактируемой поверхности, с которой в дальнейшем предстоит работать. 

При помощи переключателя Output (Результат) в настройках 

модификатора можно выбрать один из трех типов поверхности: Patch 

(Полигональная поверхность), Mesh (Поверхность) и NURBS (NURBS-

Рис. 22 – Настройки модификатора Lathe 

(Вращение вокруг оси) 

 



 

поверхность). Поскольку при создании предыдущих элементов модели мы 

использовали тип Mesh (Поверхность), выберите его и для этого элемента. 

Полученный объект должен выглядеть, как показано на рис. 23. 

 

Рис. 23 – Третий элемент консервного ножа готов 

Задание 4. Создание ручки 

1. Для создания ручки консервного ножа переключитесь в окно проекции Тор 

(Сверху) и с помощью инструмента Line (Линия) создайте кривую, 

показанную на рис. 24.  

 

Рис.  24  – Создание формы ручки консервного ножа 



 

При необходимости измените характер излома вершин так, как 

описано выше.  

2. Выделите созданный сплайн и перейдите на вкладку Modify (Изменение) 

командной панели. Раскройте список Modifier List (Список 

модификаторов) и выберите в нем модификатор Lathe (Вращение 

вокруг оси). Объект при этом приобретет вид, изображенный на рис. 25.  

 

Рис. 25 – Объект после применения модификатора Lathe (Вращение 

вокруг оси) 

Как видите, это не совсем то, что нам нужно, поэтому установим 

некоторые параметры модификатора. В свитке Parameters (Параметры) 

настроек модификатора Lathe (Вращение вокруг оси) выберите ось, 

вокруг которой будет происходить вращение сплайна, нажав кнопку Y в 

области Direction (Направление). После этого в окне проекции сплайн 

преобразуется в фигуру вращения вокруг выбранной оси.  

Определите положение оси вращения. Для этого в области Align 

(Выравнивание) настроек модификатора нажмите кнопку Min 

(Минимальный). Выбранная ранее ось вращения будет автоматически 

выровнена по краю модели. Выберите тип редактируемой поверхности, с 



 

которой в дальнейшем предстоит работать. При помощи переключателя 

Output (Результат) в настройках модификатора можно выбрать один из 

трех типов поверхности: Patch (Полигональная поверхность), Mesh 

(Поверхность) и NURBS (NURBS-поверхность). Поскольку при создании 

предыдущих элементов модели мы использовали тип Mesh (Поверхность), 

выберите его и для этого элемента (рис. 26).  

 

Рис. 26 – Объект после применения модификатора Lathe (Вращение 

вокруг оси) и задания соответствующих настроек 

3. Если теперь посмотреть на модель в окне проекции, можно заметить, что 

координаты опорной точки не совпадают с координатами центра объекта. 

Это очень распространенная проблема, возникающая в процессе 

моделирования объектов. Чтобы управлять положением центра локальной 

системы координат, необходимо выделить объект, перейти на вкладку 

Hierarchy (Иерархия) командной панели, нажать кнопку Reset Pivot 

(Задать опорную точку) в области Move/Rotate/Scale 

(Перемещение/Вращение/Масштабирование) свитка настроек Adjust 

Pivot (Установить опорную точку), нажать кнопку Affect Pivot Only 



 

(Влиять только на опорную точку). При этом оси координат изменят 

свой вид (рис. 27).  

 

Рис. 27 – Вид координатных осей после нажатия кнопки Affect Pivot 

Only (Влиять только на опорную точку) 

Ручка консервного ножа готова.  

4. Совместите этот элемент модели с другими при помощи уже известной 

вам операции выравнивания.  

5. Часто при создании трехмерных моделей едва ли не главную роль играют 

небольшие детали, которые делают объект более реалистичным. Для 

консервного ножа такими деталями являются заклепки, расположенные на 

его металлической части. Создайте их самостоятельно при помощи 

стандартного примитива Sphere (Сфера). Итоговый вариант ножа показан 

на рис. 28. 

6. Сгруппируйте объекты сцены, выполнив команду Group → Group 

(Группировать → Группировка). В диалоговом окне Group 

(Группировка) укажите название группы в поле Group name (Название 

группы), например Консервный нож. 

 

 



 

 

Рис. 28 – Консервный нож с заклепками 

 

Практическая подготовка №5 Булевые операции 

 

Цель и содержание работы 

Цель работы – создавать объекты с использованием булевых операций. 

Данная Практическая работа содержит задания, выполнение которых поможет 

изучить на практике принципы выполнения булевых операций вычитания, а 

также закрепить навыки работы со стандартными примитивами. 

Теоретическое обоснование 

Создавая объект в сцене, необходимо учитывать особенности его 

геометрии. Несмотря на то, что один и тот же трехмерный объект всегда можно 

смоделировать несколькими способами, как правило, существует один, 

который является наиболее быстрым и удобным. Одним из наиболее удобных и 

быстрых способов моделирования является создание трехмерных объектов при 



 

помощи булевых операций. Например, если два объекта пересекаются, на их 

основе можно создать третий объект, который будет представлять собой 

результат сложения, вычитания или пересечения исходных объектов.  

Рассмотрим булевы операции. На рис. 1 представлено исходное 

изображение. В 3ds MAX доступны четыре типа булевых операций.  

 

Рис. 1 – Расположение объектов перед выполнением булевых операций 

• Union (Сложение). Результатом булевого сложения двух объектов будет 

служить поверхность, образованная поверхностями объектов, 

участвующих в данной операции (рис. 2). 

• Intersection (Пересечение). Результатом булевого пересечения двух 

объектов будет поверхность, состоящая из общих участков этих объектов 

(рис. 3).  

• Subtraction (Исключение). Результатом булевого исключения двух 

объектов будет поверхность, состоящая из поверхностей первого и 

второго объектов, но не включающая в себя общие участки этих объектов 

(рис. 4). 

• Cut (Вычитание). Результатом булевого вычитания двух объектов будет 

служить поверхность, образованная исключением из поверхности одного 

объекта участков, занятых вторым объектом (рис. 5). 



 

Рис. 2 – Объекты после выполнения 

булевой операции Union 

(Сложение) 

 

Рис. 3 – Объекты после выполнения 

булевой операции 

Intersection (Пересечение)

 

Рис. 4 – Объекты после выполнения 

булевой операции 

Subtraction (Исключение) 

 

Рис. 5 – Объекты после выполнения 

булевой операции Cut 

(Вычитание) 

 

Булевы операции выполняются следующим образом: 

1. Выделите первый объект, который будет участвовать в образовании 

конечной модели.  

2. Перейдите на вкладку Create (Создание) командной панели, выберите в 

категории Geometry (Геометрия) строку Compound Objects (Составные 

объекты) и нажмите кнопку Boolean (Булева операция) (рис. 6).  



 

3. Установите параметры операции Boolean (Булева операция).  

4. Воспользуйтесь кнопкой Pick Operand В (Выбрать операнд), чтобы 

выбрать второй объект, который будет участвовать в операции. 

 

Методика и порядок выполнения работы 

Как мы уже говорили, чтобы стать мастером трехмерного моделирования, 

необходимо научиться видеть в создаваемых объектах простые формы. 

Например, моделируя кресло, вы должны увидеть, что оно состоит из немного 

деформированных стандартных примитивов. Такое видение сцены позволит 

вам безошибочно определить оптимальный способ создания объекта. Особенно 

это умение может пригодиться в тех случаях, когда требуемую форму объекта 

можно получить, используя булевы операции.  

Рис. 6 – Настройки объекта Boolean 

(Булева операция) 



 

Рассмотрим использование булевых операций на примере моделирования 

винта (рис. 7).  

 

Рис. 7 – Винт, созданный при помощи булевых операций 

1. Создайте в окне проекции объект Cylinder (Цилиндр) (рис. 8) со 

следующими параметрами: Radius (Радиус) — 30, Height (Высота) — 100, 

Height Segments (Количество сегментов по высоте) — 5, Cap Segments 

(Количество сегментов в основании) — 1, Sides (Количество сторон) — 18. 

Чтобы объект принял сглаженную форму, установите флажок Smooth 

(Сглаживание). 

 



 

Рис. 8 – Создание примитива Cylinder (Цилиндр) в окне проекции 

2. Создайте в окне проекции объект Tube (Трубка) со следующими 

параметрами: Radius 1 (Радиус 1) - 44, Radius 2 (Радиус 2) - 24, Height 

(Высота) - 150, Height Segments (Количество сегментов по высоте) — 5, 

Cap Segments (Количество сегментов в основании) — 1, Sides (Количество 

сторон) — 18. Чтобы объект принял сглаженную форму, установите 

флажок Smooth (Сглаживание). 

3. Выровняйте объект Tube (Трубка) относительно объекта Cylinder 

(Цилиндр) так, как показано на рис. 9. 

  

Рис. 9 – Выравнивание примитива Tube (Трубка) 

относительно объекта Cylinder 

(Цилиндр) 

4. Выполните первую булеву операцию следующим 

образом.  

Выделите объект Cylinder (Цилиндр). Перейдите 

на вкладку Create (Создание) командной панели, 

выберите в категории Geometry (Геометрия) 

строку Compound Objects (Составные объекты) и 

нажмите кнопку Boolean (Булева операция). 



 

Рис. 10 – Настройки объекта Boolean 

(Булева операция) 

Установите параметры булевой операции (вычитание) (рис. 10).  

Воспользуйтесь кнопкой Pick Operand В (Выбрать операнд), чтобы 

выбрать второй объект, который будет участвовать в операции – Tube 

(Трубка). 

После выполнения этой операции объект примет вид, изображенный на 

рис. 11. 

 

 

 

 

5. Создайте сплайн типа Helix (Спираль). Для этого перейдите на вкладку 

Create (Создание) командной панели, в категории Shapes (Формы) 

выберите строку Splines (Сплайны) и нажмите кнопку Helix (Спираль). 

Перейдите на вкладку Modify (Изменение) командной панели и в свитке 

Parameters (Параметры) настроек объекта Helix (Спираль) при помощи 

параметра Turns (Количество витков) установите количество витков 

равным 10. Определите направление витков против часовой стрелки, 

установив переключатель в положение CCW (Против часовой стрелки). 

 



 

Рис. 11 – Объект Cylinder (Цилиндр) после выполнения булевой 

операции вычитания 

Значение параметра Height (Высота) задайте равным 75. Укажите для 

объекта одинаковые значения параметров Radius 1 (Радиус 1) и Radius 2 

(Радиус 2) — 22. В свитке настроек Rendering (Визуализация) установите 

флажки Renderable (Отображать при визуализации) и Display Render 

Mesh (Отображать сплайн как поверхность), а также параметр Thickness 

(Толщина) равным 8. Выровняйте спираль относительно цилиндра по осям 

X и Y, а затем вручную подберите положение вдоль оси Z так, чтобы 

объект начинался под «шляпкой» (рис. 12).  

 

Рис. 12 – Установка объекта Helix (Спираль) под «шляпкой» 

первого объекта 

6. Чтобы можно было производить операции со сплайном, его необходимо 

конвертировать в Editable Mesh (Редактируемая поверхность), вызвав 

контекстное меню в окне проекции и выполнив команду Convert To → 

Convert To Editable Mesh (Преобразовать → Преобразовать в 

редактируемую поверхность).  

7. Если теперь при помощи булевой операции вычитания удалить из объекта 

Cylinder (Цилиндр) объект Helix (Спираль), вы получите деформацию, 

которая будет напоминать резьбу. Для этого выделите объект Cylinder 



 

(Цилиндр). Перейдите на вкладку Create (Создание) командной панели, 

выберите в категории Geometry (Геометрия) строку Compound Objects 

(Составные объекты) и нажмите кнопку Boolean (Булева операция). 

Установите параметры булевой операции (вычитание). Воспользуйтесь 

кнопкой Pick Operand В (Выбрать операнд), чтобы выбрать второй 

объект, который будет участвовать в операции. После этого объект примет 

вид, показанный на рис. 13.  

 

Рис. 13 – Объект Cylinder (Цилиндр) после выполнения второй булевой 

операции вычитания 

8. Осталось добавить шлиц на головку винта. Для этого используйте 

стандартный примитив Box (Параллелепипед). Перейдите на вкладку 

Create (Создание) командной панели в категорию Geometry (Геометрия), 

выберите строку Standard Primitives (Стандартные примитивы) и 

нажмите кнопку Box (Параллелепипед). Перейдите на вкладку Modify 

(Изменение) командной панели и в настройках параллелепипеда укажите 

значения параметров Length (Длина) — 15, Width (Ширина) - 80 и Height 

(Высота) – 30.  



 

Выровняйте этот объект относительно цилиндра по осям X и Y, а затем 

вручную подберите положение вдоль оси Z так, чтобы он частично 

пересекался с головкой винта, (рис. 14). 

 

Рис. 14 – Размещение объекта Box (Параллелепипед) на пересечении с 

головкой винта 

9. Теперь при помощи булевой операции вычитания удалите из первого 

объекта второй так, как это описано выше. В результате на винте появится 

шлиц (рис. 15). 



 

 

Рис. 15 – Объект Cylinder (Цилиндр) после выполнения третьей булевой 

операции вычитания 

 

Практическая подготовка №6 Моделирование при помощи редактируемых 

поверхностей 

 

 

Цель и содержание работы 

Цель работы – научиться моделировать объекты при помощи 

редактируемых поверхностей, использовать для редактирования полигонов 

команды Bevel (Выдавливание со скосом) Extrude (Выдавливание), Outline 

(Контур) и Bridge (Мост). Данная Практическая работа содержит задания, 

выполнение которых поможет на практике закрепить навыки работы со 

стандартными примитивами и применения к объектам модификаторов, а также 

установки настроек модификаторов. 

Теоретическое обоснование 



 

Программа 3ds MAX позволяет работать со следующими типами 

редактируемых поверхностей:  

• Editable Mesh (Редактируемая поверхность);  

• Editable Poly (Редактируемая полигональная поверхность);  

• Editable Patch (Редактируемая патч-поверхность);  

• NURBS Surface (NURBS-поверхность).  

Практически любой объект 3ds MAX можно преобразовать в один из этих 

типов поверхностей. Для этого правой кнопкой мыши вызовите контекстное 

меню, щелкните на пункте Convert To (Преобразовать) и в появившемся 

контекстном меню выберите один из типов (рис. 1). Все эти методы построения 

поверхностей схожи между собой, различаются они настройками 

моделирования на уровне подобъектов. Переключаясь в различные режимы 

редактирования подобъектов, можно перемещать, масштабировать, удалять и 

объединять их.  

 

 

 

 

 

 

 

В объектах типа Editable Poly (Редактируемая полигональная 

поверхность) модель состоит из многоугольников. Для работы с такими 

объектами можно использовать режимы редактирования Vertex (Вершина), 

Edge (Ребро), Border (Граница), Polygon (Полигон) и Element (Элемент) (рис. 2).  

Рис.1 – Выбор типа поверхности в 

контекстном меню 



 

 

Рис. 2 – Настройки поверхности Editable Poly (Редактируемая 

полигональная поверхность) в режиме редактирования Border 

(Граница) 

В объектах типа Editable Mesh (Редактируемая поверхность) модель 

состоит из треугольных rpaней. Для работы с Editable Mesh (Редактируемая 



 

поверхность) можно использовать режимы редактирования Vertex (Вершина), 

Edge (Ребро), Face (Грань), Polygon (Полигон) и Element (Элемент) (рис. 3). 

 

Рис. 3 – Настройки поверхности Editable Mesh (Редактируемая поверхность) 

в режиме редактирования Polygon (Полигон) 

В объектах типа Editable Patch (Редактируемая патч-поверхность) 

модель состоит из лоскутов треугольной или четырехугольной формы, которые 



 

создаются сплайнами Безье. Особенность этого типа редактируемой 

поверхности — гибкость управления формой создаваемого объекта. Для работы 

с Editable Patch (Редактируемая патч-поверхность) можно использовать 

режимы редактирования Vertex (Вершина), Edge (Ребро), Patch (Патч), Element 

(Элемент) и Handle (Вектор) (рис. 4).  

 

NURBS Surface (NURBS-поверхность) – это поверхность, построенная на 

NURBS-кривых. Этот метод построения поверхностей основан на 

Рис. 4 – Настройки поверхности 

Editable Patch (Редактируемая 

патч-поверхность) в режиме 

редактирования Handle (Вектор) 



 

неоднородных рациональных В-силайнах (Non Uniform Rational B-Splines). 

Чаще всего данный способ используется для моделирования органических 

объектов, анимации лица персонажей. Этот метод является самым сложным в 

освоении, но вместе с тем самым гибким. На рис. 5 показаны настройки 

NURBS Surface (NURBS-поверхность).  

 

Рис. 5 – Настройки NURBS Surface (NURBS-поверхность) 

Методика и порядок выполнения работы 



 

В данной лабораторной работе предлагается создать напольный 

вентилятор, который состоит из лопастей, штатива, мотора, защитной сетки и 

коробки с кнопками управления (рис. 6).  

 

Рис. 6 – Модель вентилятора 

Задание 1. Создание лопастей вентилятора 

1. Создайте стандартный примитив Sphere (Сфера) в окне проекции, после 

чего щелкните правой кнопкой мыши на названии окна проекции и в 

контекстном меню выберите режим отображения объектов Edged Faces 

(Контуры граней). В этом режиме будет видна сетчатая оболочка объекта, 

что нам в данном случае необходимо для выполнения дальнейших 

операций с этим примитивом. Перейдите на вкладку Modify (Изменение) 

командной панели. Установите для объекта следующие параметры: Radius 

(Радиус) – 40, Segments (Количество сегментов) – 9, Hemisphere 

(Полусфера) – 0,5. Также установите переключатель в положение Chop 

(Поделить пополам). Это позволит получить полусферу с количеством 

сегментов в два раза меньшим, чем на цельном объекте. В результате вы 

получите объект, показанный на рис. 7. Он будет связующим элементом 

между тремя лопастями вентилятора.  



 

 

Рис. 7 – Объект после преобразования в полусферу 

2. Чтобы была возможность изменять форму полусферы, конвертируйте 

объект в Editable Poly (Редактируемая полигональная поверхность). 

Для этого щелкните правой кнопкой мыши на объекте и выполните 

команду Convert To → Convert to Editable Poly (Преобразовать → 

Преобразовать в редактируемую полигональную поверхность) (рис. 8).  

 

Рис. 8 – Выбор команды Convert to → Convert to Editable Poly 

(Преобразовать → Преобразовать в редактируемую 

полигональную поверхность) в контекстном меню программы 



 

3. Выделите объект Sphere (Сфера) в окне проекции и перейдите на вкладку 

командной панели Modify (Изменение). Раскрыв список Editable Poly 

(Редактируемая полигональная поверхность) в стеке модификаторов, 

перейдите в режим редактирования Polygon (Полигон) (рис. 9).  

 

Рис. 9 – Режим редактирования Polygon (Полигон) объекта Sphere (Сфера) 

В нижней части полусферы имеются продолговатые участки, из которых 

нужно «вырастить» лопасти вентилятора. Нажав и удерживая клавишу 



 

Ctrl, выделите каждый третий сегмент в нижней части объекта (именно 

поэтому при задании параметров сферы мы указали девять сегментов). 

Выделенные полигоны окрасятся в красный цвет (рис. 10).  

 

Рис. 10 – Выделенные полигоны 

 

4. При полигональном моделировании можно использовать следующие 

команды: Extrude (Выдавливание), Bevel (Выдавливание со скосом), 

Outline (Контур) и др. Применить их можно двумя способами: вручную 

или устанавливая параметры выбранной операции в окне настроек.  

Чтобы проделать данные операции вручную, воспользуйтесь одной из 

следующих операций:  

• щелкните правой кнопкой мыши в любом месте окна проекции и в 

появившемся контекстном меню выберите строку, соответствующую 

названию нужной операции;  



 

• нажмите кнопку, соответствующую нужной операции, в свитке Edit 

Polygons (Редактирование полигонов) настроек объекта на 

командной панели.  

Чтобы открыть окно настроек операции, выполните одно из следующих 

действий:  

• нажмите кнопку Settings (Настройки), расположенную возле строки с 

названием операции в контекстном меню;  

• нажмите кнопку Settings (Настройки), которая находится возле 

кнопки с названием операции в свитке Edit Polygons 

(Редактирование полигонов) настроек объекта на командной 

панели.  

Использование окна Settings (Настройки) оправдано в том случае, когда 

необходимо совершить операцию с выбранным инструментом, но размеры 

окна проекции не позволяют сделать это вручную. В нашем случае это 

именно так. Нам необходимо выдавить полигоны на достаточно большое 

расстояние. Сделать это вручную одним щелчком мыши не удастся, а при 

выполнении операции несколько раз подряд будет увеличиваться 

количество полигонов, что не очень хорошо. Поэтому воспользуемся 

окном Settings (Настройки).  

Нажмите кнопку Settings (Настройки), 

расположенную возле кнопки Extrude 

(Выдавливание) в свитке Edit Polygons 

(Редактирование полигонов) настроек 

объекта на командной панели (рис. 11).  

 

 

Рис. 11 – Кнопка Settings (Настройки) 



 

В появившемся окне Extrude Polygons (Выдавливание полигонов) 

установите значение параметра Extrusion Height (Высота выдавливания) 

равным 260 (рис. 12). Модель примет вид, показанный на рис. 13. 

 

Рис. 12 – Окно Extrude Polygons 

(Выдавливание полигонов)

Рис. 13 – Объект после выдавливания полигонов 

5. Не снимая выделение с полигонов, выполните команду Scale 

(Масштабирование) в плоскости XY. Это позволит увеличить площадь 

лопастей (рис. 14). 

6. Преобразуйте полученную угловатую модель в объект со сглаженными 

формами. Воспользуйтесь модификатором MeshSmooth (Сглаживание). 

Выйдите из режима редактирования Polygon (Полигон), щелкните на 

вкладке Modify (Изменение) и выберите модификатор MeshSmooth 



 

(Сглаживание) из списка модификаторов. В свитке Subdivision Amount 

(Количество разбиений) настроек модификатора установите значение 

параметра Iterations (Количество итераций) равным трем (это 

необходимое количество итераций для сглаживания острых углов). 

 

Рис. 14 – Объект после масштабирования 

После этого объект станет похож на настоящие лопасти вентилятора 

(рис. 15), однако модель все еще будет иметь недостатки.  

 

Рис. 15 – Объект после применения модификатора MeshSmooth 

(Сглаживание) 



 

7. Лопасти необходимо повернуть на определенный угол, как в реальных 

вентиляторах. Для этого перейдите на вкладку Modify (Изменение) 

командной панели. Раскройте строку MeshSmooth (Сглаживание) в стеке 

модификаторов, щелкнув на значке «плюс». Переключитесь в режим 

редактирования Vertex (Вершина) — так вы сможете управлять формой 

сглаженного объекта. В центре полученного объекта есть контрольные 

точки, а напротив каждой лопасти по две пары управляющих вершин – эти 

точки обозначены синим цветом (рис. 16).  

 

Рис. 16 – Объект в режиме Vertex (Вершина) модификатора MeshSmooth 

(Сглаживание) 

Если перейти в окно проекции Front (Спереди), можно заметить, что 

лопасти немного приподняты. Это объясняется тем, что крайние полигоны, 

которые использовались при операции Extrude (Выдавливание), были 

повернуты под небольшим углом (рис. 17). 

 



 

 

Рис. 17 – Вид модели в окне проекции Front (Спереди) 

8. Перейдите в окно проекции Тор (Сверху) и выделите управляющие точки 

модификатора MeshSmooth (Сглаживание), которые расположены в 

центре модели. Перейдите в окно проекции Front (Спереди) и измените 

положение управляющих точек, передвинув их немного вверх (рис. 18). 

 

Рис. 18 – Вид модели в окне проекции Front (Спереди) после изменения 

положения управляющих точек модификатора MeshSmooth 

(Сглаживание) 



 

9. Теперь повернем лопасти. Перейдите в окно проекции Perspective 

(Перспектива) и выделите по одной паре управляющих точек 

модификатора MeshSmooth (Сглаживание) с правой стороны каждой 

лопасти. Используя инструмент Move (Перемещение), переместите точки 

вверх по оси Z. В результате этой операции каждая лопасть будет иметь 

приподнятый край. Выполните команду Edit → Select Invert (Правка → 

Инвертировать выделение). После этого выделенными станут все точки, 

которые до этого были не выделены. Поскольку нас интересуют только 

крайние точки возле лопастей, необходимо снять выделение с центральных 

управляющих точек модификатора MeshSmooth (Сглаживание). Это можно 

сделать, выделяя центральные точки, удерживая при этом нажатой 

клавишу Alt. Используя инструмент Move (Перемещение), передвиньте 

выделенные точки вниз по оси Z. В результате этой операции каждая 

лопасть будет иметь приподнятый и опущенный край (рис. 19).  

 

Рис. 19 – Готовая модель лопастей вентилятора 

 



 

Задание 2. Создание защитной сетки 

1. Для создания защитной сетки будем использовать стандартный примитив 

Sphere (Сфера). Перейдите в окно проекции Тор (Сверху) и, щелкнув в 

центре модели лопастей вентилятора, создайте объект с радиусом, 

достаточным для того, чтобы охватить модель. Перейдите в окно проекции 

Perspective (Перспектива) и уменьшите объект при помощи операции Scale 

(Масштабирование) вдоль оси Z (рис. 20).  

 

Рис. 20 – Вид защитной сетки после выполнения операции Scale 

(Масштабирование) 

2. Перейдите на вкладку Modify (Изменение) командной панели и 

примените к объекту модификатор Lattice (Решетка).  

Напомним, что этот модификатор создает на поверхности объекта решетку 

на полигональной основе. Вместо ребер объекта модификатор создает 

решетку, а на месте вершин  устанавливает ее узлы (рис. 21). В настройках 

модификатора подберите радиус решетки при помощи параметра Radius 

(Радиус), установите количество сторон решетки Sides (Количество 



 

сторон) равным 9. В образованной при помощи данного модификатора 

решетке должны отображаться только прутья.  

 

Рис. 21 – Вид объекта после применения модификатора Lattice (Решетка) 

Чтобы скрыть узлы, в области Geometry (Геометрия) установите 

переключатель в положение Struts Only from Edges (Только прутья 

решетки). Чтобы прутья решетки выглядели сглажено, установите флажок 

Smooth (Сглаживание) (рис. 22).  

 

Рис. 22 – Вид объекта после применения модификатора Lattice (Решетка) 

и установки необходимых параметров 



 

3. Можно также изменить количество прутьев решетки. Для этого 

необходимо выделить примитив Sphere (Сфера) и в стеке модификаторов 

вернуться к моменту его создания. Плотность размещения прутьев 

решетки зависит от количества сегментов созданного объекта — значения 

параметра Segments (Количество сегментов). Поэтому, чтобы изменить 

количество прутьев, уменьшите или увеличьте этот параметр.  

4. Последний штрих создания решетки – установка на ее торце 

пластмассового колпачка (не забывайте о важности небольших деталей, 

которые придают модели реалистичность). Для этого клонируйте объект 

Sphere (Сфера) – выделите объект, щелкнув на нем мышью, и выполните 

команду Edit → Clone (Правка → Клонировать). В появившемся окне 

Clone Options (Параметры клонирования) выберите вариант 

клонирования Сору (Независимая копия объекта). Перейдите на вкладку 

Modify (Изменение) командной панели и в стеке модификаторов удалите 

из списка модификатор Lattice (Решетка) (рис. 23).  

 

Вы получите объект, который совпадает по расположению с 

исходным. 

Внимание. Удаление модификатора происходит только для выделенного 

объекта, т.е. для второй сферы, полученной в результате клонирования. 

При этом решетка (первая сфера) остается неизменной, потому что при 

клонировании объекта был выбран вариант Сору (Независимая копия 

объекта). Если бы в окне Clone Options (Параметры клонирования) мы 

Рис. 23 – Удаление модификатора 

Lattice (Решетка) из стека 



 

указали Instance (Привязка), то копия была бы связана с исходным 

объектом и при изменении параметров одного объекта автоматически 

были бы изменены параметры другого. В таком случае модификатор был 

бы удален и для исходного объекта.  

Перейдите на вкладку Modify (Изменение) командной панели и 

увеличивайте значение параметра Hemisphere (Полусфера) до тех пор, 

пока сфера не превратится в колпачок нужного размера (рис. 24). 

 

Рис. 24 – Клонированная сфера, уменьшенная в размере 

5. Выровняйте колпачок относительно защитной сетки. Для этого выделите 

колпачок, щелкнув на нем мышью. Выполните команду Tools → Align 

(Инструменты → Выравнивание). При этом курсор изменит форму. 

Кликните на объекте-сетке. На экране появится окно Align Selection 

(Выравнивание выделенных объектов), в котором необходимо указать, 

по какому принципу будет происходить выравнивание. Установите 

флажок Z Position (Z-позиция). Установите переключатель Current Object 

(Объект, который выравнивается) в положение Minimum (По 



 

минимальным координатам выбранных осей). Установите переключатель 

Target Object (Объект, относительно которого выравнивается) в положение 

Maximum (По максимальным координатам выбранных осей). Нажмите 

кнопку Apply (Применить) или ОК.  

Модель защитной сетки готова (рис. 25). 

 

Рис. 25 – Готовая модель защитной сетки с лопастями вентилятора внутри 

Задание 3. Создание мотора для вентилятора 

Для его создания мотора используем стандартный примитив Chamfer 

Cylinder (Цилиндр с фаской). Мотор состоит из трех частей: корпуса, 

вращающегося вала и крепежного элемента. Сначала создадим крепежный 

элемент, который соединяет вращающийся вал с лопастями и должен быть 

расположен в центре пропеллера.  

1. Создайте в окне проекции объект Chamfer Cylinder (Цилиндр с фаской) 

со следующими параметрами: Radius (Радиус) – 73, Height (Высота) – 62, 

Fillet (Закругление) – 9, Height Segments (Количество сегментов по высоте) 

– 3, FilletSegs (Количество сегментов на фаске) – 4, Cap Segments 



 

(Количество сегментов в основании) – 1, Sides (Количество сторон) – 18. 

Чтобы объект принял сглаженную форму, установите флажок Smooth 

(Сглаживание). 

2. Выровняйте полученный объект относительно лопастей. Для этого в окне 

Align Selection (Выравнивание выделенных объектов) установите 

флажки Y Position (Y-позиция) и X Position (Х-позиция). Установите 

переключатель Current Object (Объект, который выравнивается) в 

положение Pivot Point (Опорная точка). Установите переключатель Target 

Object (Объект, относительно которого выравнивается) в положение Pivot 

Point (Опорная точка). Нажмите кнопку Apply (Применить).  

Установите флажок Z Position (Z-позиция). Установите переключатель 

Current Object (Объект, который выравнивается) в положение Center (По 

центру). Установите переключатель Target Object (Объект, относительно 

которого выравнивается) в положение Center (По центру). Нажмите кнопку 

Apply (Применить) или ОК. Теперь сцена будет выглядеть, как показано 

на рис. 26.  

 

Рис. 26 – В сцену добавлен крепежный элемент 



 

3. Выделите объект Chamfer Cylinder (Цилиндр с фаской), щелкнув на нем 

мышью, и выполните команду Edit → Clone (Правка →Клонировать). В 

появившемся окне Clone Options (Параметры клонирования) выберите 

вариант клонирования Сору (Независимая копия объекта).  

Этот объект будет играть роль вращающегося вала. Установите для 

клонированного объекта следующие параметры: Radius (Радиус) – 13, 

Height (Высота) – -115, Fillet (Закругление) – 0, Height Segments 

(Количество сегментов по высоте) – 3, FilletSegs (Количество сегментов на 

фаске) – 1, Cap Segments (Количество сегментов в основании) – 1, Sides 

(Количество сторон) – 13. Чтобы объект принял сглаженную форму, 

установите флажок Smooth (Сглаживание). В результате сцена будет 

выглядеть, как показано на рис. 27. 

 

Рис. 27 – В сцену добавлен «вращающийся» вал 

4. Еще раз клонируйте объект Chamfer Cylinder (Цилиндр с фаской), щелкнув 

на нем мышью, и выполните команду Edit → Clone (Правка → 

Клонировать). В появившемся окне Clone Options (Параметры 

клонирования) выберите вариант клонирования Сору (Независимая копия 

объекта). Обратите внимание, что в данном случае неважно, какой из 



 

объектов клонировать – первый цилиндр или второй. Для вновь 

созданного объекта, который будет играть роль корпуса, установите 

следующие параметры: Radius (Радиус) – 125, Height (Высота) – -225, Fillet 

(Закругление) – 17, Height Segments (Количество сегментов по высоте) – 5, 

FilletSegs (Количество сегментов на фаске) – 3, Cap Segments (Количество 

сегментов в основании) – 1, Sides (Количество сторон) – 25. Чтобы объект 

принял сглаженную форму, установите флажок Smooth (Сглаживание).  

5. Выполните операцию Move (Перемещение) вдоль оси Z таким образом, 

чтобы корпус мотора «проходил» сквозь защитную сетку. В результате 

сцена будет выглядеть, как изображено на рис. 28.  

 

Рис. 28 – Сцена после добавления корпуса мотора 

6. Как видим, полученная модель расположена вертикально. Необходимо ее 

повернуть. Поскольку все объекты модели мы создавали отдельно, 

выполнить вращение будет не очень просто. Чтобы манипулировать 

объектами было проще, сгруппируйте их. Для этого воспользуйтесь 

сочетанием клавиш Ctrl+A, чтобы выделить все объекты в сцене. 

Выполните команду Group → Group (Группировать → Группировка). В 

диалоговом окне Group (Группировка) укажите название группы в поле 

Group Name (Название группы), например Верхняя часть вентилятора. 



 

7. Поверните модель на   -90° вокруг оси X (рис. 29). 

 

Рис. 29 – Модель повернута в нужном направлении 

8. Последнее, что необходимо сделать на этом этапе, — подкорректировать 

форму корпуса мотора. Нужно создать выступ, который будет соединять 

верхнюю часть вентилятора со штативом. Для этого разгруппируйте 

объекты, выполнив команду Group → Ungroup (Группировать → 

Разгруппировка). Перейдите в окно проекции Bottom (Снизу). Щелкните 

правой кнопкой мыши на названии окна проекции и в контекстном меню 

выберите режим отображения объектов Edged Faces (Контуры граней). В 

этом режиме будет видна сетчатая оболочка объекта.  

9. Чтобы можно было изменять форму корпуса, конвертируйте объект в 

Editable Poly (Редактируемая полигональная поверхность).  

Для этого щелкните правой кнопкой мыши на объекте и выполните 

команду Convert To → Convert to Editable Poly (Преобразовать → 

Преобразовать в редактируемую полигональную поверхность). 



 

Выделите корпус мотора в окне проекции и перейдите на вкладку 

командной панели Modify (Изменение). Раскрыв список Editable Poly 

(Редактируемая полигональная поверхность) в стеке модификаторов, 

перейдите в режим редактирования Polygon (Полигон).  

10. Нажав и удерживая клавишу Ctrl, выделите шесть полигонов, 

расположенных в нижней части объекта так, как это показано на рис. 30. 

Выделенные полигоны окрасятся в красный цвет. 

 

Рис. 30 – Выделение полигонов в нижней части корпуса мотора 

Нажмите кнопку Settings (Настройки), расположенную возле кнопки 

Extrude (Выдавливание) в свитке Edit Polygons (Редактирование 

полигонов) настроек объекта на командной панели. 

В появившемся окне Extrude Polygons (Выдавливание полигонов) 

установите значение параметра Extrusion Height (Высота выдавливания) 

равным 80. После выполнения этой операции модель примет вид, 

показанный на рис. 31.  



 

 

Рис. 31 – Объект после выдавливания полигонов 

11. Чтобы вентилятор было удобнее переносить, на корпусе мотора часто 

делают ручку. Создадим такую ручку при помощи команды Bridge (Мост). 

С ее помощью удобно управлять формой трехмерной оболочки, 

выстраивая полигоны между двумя и более выделенными элементами 

сетки модели.  

Выделите два полигона в верхней части модели. При этом они станут 

красными. Щелкните правой кнопкой мыши в окне проекции, выберите 

команду Extrude (Выдавливание) и выдавите полигоны на некоторое 

расстояние (рис. 32).  Повторите операцию, создав еще по одному 

полигону на получившемся выступе (рис. 33).  



 

 

Рис. 32 – Выдавливание полигонов в верхней части корпуса мотора 

 

Рис. 33 – Повторное выдавливание 

12. Теперь используем для верхних полигонов команду Bridge (Мост). 

Нажмите кнопку Settings (Настройки), расположенную возле кнопки 



 

Bridge (Мост) в свитке Edit Polygons (Редактирование полигонов) 

настроек объекта на командной панели. В окне Bridge (Мост) укажите 

параметры операции (рис. 34). 

 

 

 

 

Рис. 34 – Окно Bridge (Мост) 

 

Измените параметр Segments 

(Количество сегментов). Чем больше 

сегментов, тем более гладкой будет 

итоговая модель.  

Выйдите из режима редактирования 

Polygon (Полигон) и выберите из списка 

Modifier List (Список модификаторов) 

модификатор TurboSmooth 

(Турбосглаживание). В настройках 

модификатора укажите значение 

параметра Iterations (Количество 

итераций) равным четырем (рис. 35).  

 

 

 

Теперь наша модель примет вид, показанный на рис. 36. 

Рис. 35 – Настройки модификатора 

TurboSmooth (Турбосглаживание) 

 



 

 

Рис. 36 – Ручка на корпусе мотора для удобного переноса вентилятора  

Задание 4. Создание штатива 

Штатив состоит из стойки и крестовины, которая придает конструкции 

устойчивость. Смоделируем их при помощи стандартного примитива Cylinder 

(Цилиндр) и редактируемых поверхностей.  

1. Создайте в окне проекции стандартный примитив Cylinder (Цилиндр) со 

следующими параметрами: Radius (Радиус) – 40, Height (Высота) – 850, 

Height Segments (Количество сегментов по высоте) – 13, Cap Segments 

(Количество сегментов в основании) – 1, Sides (Количество сторон) – 16. 

Чтобы объект принял сглаженную форму, установите флажок Smooth 

(Сглаживание).  

2. Полученный объект необходимо выровнять таким образом, чтобы он 

располагался в плоскости XY под выступом, созданным на корпусе 

мотора. Сделать это можно двумя способами. Более простой, но в то же 

время не совсем точный, — перейти в окно проекции Bottom (Снизу) и при 

помощи команды Move (Перемещение) подобрать положение объекта на 



 

глаз. Чтобы более точно расположить штатив относительно выступа, 

созданного на корпусе мотора, необходимо использовать команду 

выравнивания. Сделать это можно только в том случае, если выступ будет 

являться самостоятельным объектом. Чтобы преобразовать его в 

независимый объект, выделите корпус мотора. Перейдите на вкладку 

Modify (Изменение) командной панели. Раскройте строку Editable Poly 

(Полигональная поверхность) в стеке модификаторов, щелкнув на значке 

плюса. Переключитесь в режим редактирования Vertex (Вершина). Нажав 

и удерживая клавишу Ctrl, выделите все полигоны выступа. В свитке Edit 

Geometry (Редактирование геометрических характеристик) нажмите 

кнопку Detach (Отсоединить) (рис. 37). Теперь выступ будет 

самостоятельным объектом. Введите в 

появившемся окне его имя, например 

выступ. 

 

 

 

 

 

 

 

 

3. Выровняйте штатив относительно созданного объекта. Для этого в окне 

Align Selection (Выравнивание выделенных объектов) выполните 

следующее. Установите флажки X Position (Х-позиция) и Y Position (Y-

позиция). Установите переключатель Current Object (Объект, который 

Рис. 37 – Кнопка Detach (Отсоединить) в 

свитке Edit Geometry 

(Редактирование геометрических 

характеристик) 



 

выравнивается) в положение Center (По центру). Установите 

переключатель Target Object (Объект, относительно которого 

выравнивается) в положение Center (По центру). Нажмите кнопку Apply 

(Применить) или ОК.  

Штатив будет выровнен относительно выступа, в чем можно убедиться, 

перейдя в окно проекции Bottom (Снизу) (рис. 38).  

 

Рис. 38 – Штатив выровнен относительно выступа 

4. Теперь создадим крестовину, которая придаст конструкции устойчивость. 

Для этого при помощи команды Extrude (Выдавливание) выдавим 

полигоны в нижней части цилиндра. Чтобы можно было изменять форму 

штатива, конвертируйте объект в Editable Poly (Редактируемая 

полигональная поверхность). Для этого щелкните правой кнопкой мыши 

на объекте и выполните команду Convert To → Convert to Editable Poly 

(Преобразовать → Преобразовать в редактируемую полигональную 

поверхность) (рис. 39).  



 

 

Рис. 39 – Выбор в контекстном меню команды Convert To → Convert to 

Editable Poly (Преобразовать → Преобразовать в 

редактируемую полигональную поверхность) 

Выделите штатив в окне проекции и перейдите на вкладку командной 

панели Modify (Изменение). Раскрыв список Editable Poly 

(Редактируемая полигональная поверхность) в стеке модификаторов, 

перейдите в режим редактирования Polygon (Полигон). Нажав и 

удерживая клавишу Ctrl, выделите каждый четвертый полигон, 

расположенный в нижней части объекта так, как это показано на рис. 40. 

Выделенные полигоны станут красными.  

Чтобы крестовина имела достаточную толщину и могла обеспечить 

устойчивость конструкции, необходимо выдавливать полигоны большей 

площади, чем те, из которых состоит цилиндр. Для этого используем 

команду Outline (Контур). Щелкните на кнопке Settings (Настройки), 

расположенной справа от Outline (Контур) в свитке Edit Polygons 



 

(Редактирование полигонов) настроек объекта на командной панели. В 

окне Outline Polygons (Увеличение полигонов) установите значение 

параметра Outline Amount (Величина контура) равным 8 (рис. 41).  

 

Рис. 40 – Выделение полигонов для выдавливания 

 

Рис. 41 – Диалоговое окно Outline Polygons (Увеличение полигонов) 

Щелкните на кнопке Settings (Настройки), расположенной справа от 

кнопки Extrude (Выдавливание) в свитке Edit Polygons (Редактирование 

полигонов) настроек объекта на командной панели. В окне Extrude 

Polygons (Выдавливание полигонов) установите значение параметра 

Extrusion Height (Высота выдавливания) равным 475. 

В результате штатив будет выглядеть, как показано на рис. 42. 



 

 

Рис. 42 – Объект после выдавливания полигонов 

Задание 5. Создание коробки с кнопками управления 

Наконец, последний элемент напольного вентилятора — это коробка с 

кнопками управления. Для ее создания мы также будем использовать 

редактируемые поверхности.  

1. В основе этого объекта лежит примитив ChamferBox (Параллелепипед со 

скошенными углами). Создайте его, перейдите на вкладку Modify 

(Изменение) командной панели и установите для него следующие 

параметры: Length (Длина) – 130, Height (Высота) – 550, Width (Ширина) – 

130 и Fillet (Закругление) – 5.  

2. Созданный объект необходимо выровнять относительно выступа. Для 

этого в окне Align Selection (Выравнивание выделенных объектов) 

выполните следующее.  

Установите флажки X Position (Х-позиция) и Y Position (Y-позиция). 

Установите переключатель Current Object (Объект, который 

выравнивается) в положение Center (По центру). Установите 

переключатель Target Object (Объект, относительно которого 



 

выравнивается) в положение Center (По центру). Нажмите кнопку Apply 

(Применить).  

Установите флажок Z Position (Z-иозиция). Установите переключатель 

Current Object (Объект, который выравнивается) в положение Maximum 

(По максимальным координатам выбранных осей). Установите 

переключатель Target Object (Объект, относительно которого 

выравнивается) в положение Minimum (По минимальным координатам 

выбранных осей). Нажмите кнопку Apply (Применить) или ОК. В 

результате объекты будут располагаться так, как показано на рис. 43.  

 

Рис. 43 – Вид объектов после выравнивания 

3. Чтобы можно было изменять форму коробки и выдавить кнопки, 

конвертируйте объект в Editable Poly (Редактируемая полигональная 

поверхность). Для этого щелкните правой кнопкой мыши на объекте и 

выполните команду Convert To → Convert to Editable Poly 

(Преобразовать → Преобразовать в редактируемую полигональную 

поверхность).  



 

4. Выделите объект ChamferBox (Параллелепипед со скошенными углами) в 

окне проекции и перейдите на вкладку командной панели Modify 

(Изменение). Раскрыв список Editable Poly (Редактируемая 

полигональная поверхность) в стеке модификаторов, перейдите в режим 

редактирования Edge (Ребро). Нажав и удерживая клавишу Ctrl, выделите 

группы, содержащие по четыре ребра, в центральной части объекта так, 

как это показано на рис. 44. При этом они станут красными.  

 

Рис. 44 – Выделение ребер на объекте ChamferBox (Параллелепипед со 

скошенными углами) 

Чтобы объединить расположенные рядом полигоны, в свитке Edit Edges 

(Редактирование ребер) настроек редактируемой поверхности удалите 

эти ребра с помощью кнопки Remove (Удалить) (рис. 45).  

 

 

 

 

Рис. 45 – Кнопка Remove (Удалить) в свитке 

Edit Edges (Редактирование ребер) 



 

5. Переключитесь в режим редактирования Polygon (Полигон). При этом 

выделенная область будет выглядеть так, как изображено на рис. 46.  

 

Рис. 46 – Выделенная область в режиме редактирования Polygon (Полигон) 

Воспользуемся командой Extrude (Выдавливание) для вдавливания 

полигонов, с которыми мы работаем. Щелкните на кнопке Settings 

(Настройки), расположенной справа от кнопки Extrude (Выдавливание) 

в свитке Edit Polygons (Редактирование полигонов) настроек объекта на 

командной панели. В окне Settings (Настройки) установите значение 

параметра Extrusion Height (Высота выдавливания) равным – 10. В 

результате коробка будет выглядеть, как показано на рис. 47. 

6. Чтобы уменьшить площадь полигонов, с которыми мы работаем, 

воспользуемся командой Outline (Контур). Щелкните на кнопке Settings 

(Настройки), расположенной справа от кнопки Outline (Контур) в свитке 

Edit Polygons (Редактирование полигонов) настроек объекта на 

командной панели. В окне Outline Polygons (Увеличение полигонов) 

установите значение параметра Outline Amount (Величина контура) 

равным -2. 



 

 

Рис. 47 – Вид коробки после выполнения команды Extrude (Выдавливание) 

Воспользуемся инструментом Bevel (Выдавливание со скосом) для 

создания кнопок. Щелкните на кнопке Settings (Настройки), 

расположенной справа от кнопки Bevel (Выдавливание со скосом) в свитке 

Edit Polygons (Редактирование полигонов) настроек объекта на 

командной панели. В окне Bevel Polygons (Скос полигонов) установите 

значение параметра Height (Высота) равным 25. В результате коробка 

будет выглядеть, как изображено на рис. 48.  

 

Рис. 48 – Созданная кнопка 



 

На этом моделирование коробки с кнопками управления закончено.  

Задание 6. Завершающий этап 

1. На последнем этапе создадим деталь, скрепляющую верхнюю часть 

вентилятора с коробкой. Не выходя из режима редактирования Polygon 

(Полигон), выделите два крайних полигона в верхней части коробки так, 

как это показано на рис. 49. При этом они станут красными.  

 

Рис. 49 – Выделение полигонов в верхней части объекта ChamferBox 

(Параллелепипед со скошенными углами) 

2. Воспользуйтесь инструментом Bevel (Выдавливание со скосом). 

Щелкните на кнопке Settings (Настройки), расположенной справа от 

кнопки Bevel (Выдавливание со скосом) в свитке Edit Polygons 

(Редактирование полигонов) настроек объекта на командной панели. В 

окне Bevel Polygons (Скос полигонов) установите значение параметра 

Height (Высота) равным 88. В результате коробка будет выглядеть так, как 

показано на рис. 50. 

3. Теперь выделите все полигоны на созданных выступах и преобразуйте 

полученную угловатую модель в объект со сглаженными формами.  

Для этого используйте команду MeshSmooth (Сглаживание). 



 

 

Рис. 50 – Вид коробки после выполнения операции Bevel 

(Выдавливание со скосом) 

Щелкните на одноименной кнопке в свитке Edit Polygons 

(Редактирование полигонов) настроек объекта на командной панели. 

Чтобы получить лучший результат, повторите эту операцию. В результате 

скрепляющая деталь будет выглядеть, как показано на рис. 51. 

 

Рис. 51 – Скрепляющая деталь после применения команды 

MeshSmooth (Сглаживание) 



 

4. Сгладьте углы коробки, чтобы поверхность скрепляющей детали была 

более ровной. Выделите объект, перейдите на вкладку Modify 

(Изменение) командной панели, выберите из списка Modifier List 

(Список модификаторов) модификатор Smooth (Сглаживание). В его 

настройках установите флажок AutoSmooth (Автоматическое 

сглаживание). Объект приобретет вид, изображенный на рис. 52.  

 

Рис. 52 – Скрепляющая деталь после применения модификатора 

Smooth (Сглаживание) 

На этом моделирование напольного вентилятора завершено. 
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